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Overview 
This section provides background information about the structure and functionality 
included in the Land Atmosphere Water Simulator (LAWS) Version 2.0 model. 

Introduction 
The Land Atmosphere Water Simulator (LAWS) is a tool designed for the management 
of large-scale, multi-organizational water supply systems.  LAWS differs from other 
water management models in several significant ways.  

First, LAWS simulates daily, field-scale land, crop, and water management practices. It 
provides users with tools to simulate alternative methods for managing soil moisture on a 
daily basis during the irrigation season based on soil properties, crop type and growth 
stage.  This approach permits LAWS to compute evapotranspiration, soil water content, 
surface water ponding, runoff, canal and drain losses, return flows to rivers, and deep 
percolation to groundwater at level of spatial and temporal resolution not present in 
existing planning and operations models.  Although LAWS performs these calculations at 
the field scale, LAWS also provides users with ability to aggregate these results within 
larger user definable areas so that water budgets can be readily computed for arbitrary 
organizational regions.  

Second, LAWS does not solve any governing flow equations except continuity nor is it 
an optimization model. However, LAWS V2 does offer several capabilities not typically 
found in most water resource system operations models. These features include the 
ability to simulate soil evaporation and crop transpiration as separate components of 
evapotranspiration, effects of soil moisture content on crop transpiration, crop rotations 
and root zone dynamics, effects of unsaturated flow on infiltration and runoff, effects of 
irrigation on water quality and effects of groundwater pumping on aquifer water levels 
and stream seepages.  These effects are all simulated using analytical functions as 
opposed to numerical methods.   This approach allows LAWS to be very computationally 
efficient but it requires the LAWS user to provide key input data from other sources of 
information such as field studies, remote sensing, GIS databases, physical process 
models, and expert judgment. In some instances such as for unsaturated flow soil 
properties and groundwater simulation, LAWS provides tools to assist the user in model 
parameterization. Although LAWS provides users with multiple methods for allocating 
water supplies and making priority based delivery decisions, LAWS does not employ any 
mathematical methods to determine what is the "best" allocation of water. In contrast, 
LAWS provides users with a powerful graphical user interface (GUI) that allows users to 
readily change water allocation and delivery priorities, land and crop management 
practices, and infrastructure characteristics to compare the effects of alternative system 
configurations on reservoir water supplies.  
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Third, LAWS has a native GIS capability built directly into the GUI. This GIS capability 
allows users to setup and analyze spatially accurate LAWS simulations across a span of 
scales ranging from large regional watersheds to sub-regions contained with individual 
fields.  LAWS also provides users with the capability to import imagery, maps, and GIS 
information developed with commercially available software packages. Furthermore, 
LAWS has been developed from the Corp of Engineers Water Management System 
(CWMS) software from which it has inherited a powerful suite of tools to examine model 
outputs including side by side comparisons of outputs from multiple alternative 
simulations and animations of spatial and temporal time series results.  

System Manager 
LAWS captures both the spatial and hierarchical organization of a water supply system. 
In LAWS, the supply system is conceptualized as a series of nested spatial units that 
range in size from multi-regional watersheds to individual land units as small as fields. 
The largest scale land area is associated with a System Manger (SM).  In a LAWS 
simulation, there may be one or more SMs.  At the next smaller spatial scale, each Area 
Manager (AM) manages a particular region within the system.  Within these regions, 
there are one or more Delivery Managers (DM).  These DMs represent sub-regions 
within the AM region where water management is performed differently based on some 
unique characteristics of the land or the water supply associated with the sub-region.  At 
the smallest scale, an individual land unit is represented by a Land Manager (LM).  Each 
LM is located within a single DM sub-region.  In LAWS, the geospatial locations of 
major reservoirs, rivers, canals and drains are explicitly located through its GIS capability 
down to the AM-scale. Although simulated mathematically, smaller scale conveyance 
infrastructure at the DM- and LM-scales is not explicitly geospatially referenced.  The 
LAWS spatial organization is shown in Figure 1 below.  
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Figure 1. LAWS Spatial Organization 
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The LAWS hierarchical organization represents the basic structure for managing requests 
for water supplies and making management decisions necessary for determining the 
amounts of water to be released from reservoirs as well as the amounts of supply to be 
provided by groundwater pumping and drain water reuse by individual Land Managers. 
The LAWS hierarchical organization is presented on Figure 2 below. 
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Figure 2.  LAWS Hierarchical Organization 

Each SM operates one of more reservoirs which may be located on different rivers 
systems within a regional watershed.  Each reservoir consists of one or more accounts 
each of which is associated with a specific AM. The volume of water in each AM 
account is determined by a user specified percentage of the conservation pool.  The 
amount of water in the conservation pool is reset on annual basis during the course of a 
multi-year simulation.  The LAWS user has the option to allow an AM account to receive 
additional supply during a simulation in order to determine how much additional supply 
would be necessary to meet their water requirements over the simulation period. 

At each daily time step, the SM can use either a sequential or balanced allocation method 
to determine how much water to release from each of the reservoirs it manages.  In a 
sequential allocation the highest ranking account associated with a particular AM is fully 
depleted before the next highest ranking account is utilized.  In a balanced allocation, 
water from each reservoir account associated with a particular AM is utilized 
simultaneously in a user specified proportion.  If an account is completely utilized before 
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the simulation is complete, the balance allocation ratios are recomputed to reflect the 
relative weighting of the accounts that still have remaining water supplies. 

The total amount of the SM deliveries must be constrained by the available release 
capacity of the reservoir and the capacity of the downstream river channels to convey 
releases without causing flood damage.  Since LAWS is intended to work in conjunction 
with other water management models, the reservoir release capacity can be specified at 
every time step.  This approach permits LAWS reservoir releases to be constrained by 
other in-stream flow requirements that are not explicitly modeled in a LAWS simulation. 
This capability is accomplished by specifying a LAWS reservoir release capacity as the 
maximum physical release capacity minus the non-consumptive use flows that are 
released for other in-stream flow or water quality requirements.  Typically, these 
regulatory releases would be simulated with another model and a daily time series of 
maximum reservoir release capacities would be computed for a LAWS simulation. 

In LAWS, SM reservoir releases are delivered to AMs through an explicitly modeled 
network of rivers, canals, and drains.  The hydraulic properties of these conveyance 
system features are represented explicitly at user defined reaches along the channels.  The 
LAWS user specifies a maximum flow capacity for each reach and can simulate 
accretions and depletions in these reaches with simple gain/loss factors.  The transit time 
for water flowing through reaches is also specified by the user.  

It is important to recognize that LAWS does not solve the governing equations of flow in 
open channels.  LAWS simulates flow hydraulics and surface-groundwater interactions 
by using user specified factors.  Consequently, the LAWS user must develop this 
information from field studies, simulations using hydrodynamic and groundwater models, 
or expert judgment.  This simplistic approach used throughout LAWS avoids the 
computational overhead and complex data requirements of numerical models.  However, 
since LAWS is a mass conservative model, it can be used to determine water budgets 
from the regional-scale all the way down to the field-scale.  Further, the simplicity of the 
approach permits the LAWS user to efficiently compare alternative land and water 
management practices, infrastructure characteristics and configurations as well as water 
delivery priorities explicitly established at each level of the multi-organizational 
hierarchy. 

Area Manager 
A LAWS Area Manger is one of the four levels in the LAWS hierarchical organization. 
An AM represents an organizational unit that manages of water supplies for a particular 
spatial region within the water supply system.    In the LAWS hierarchy, an AM is the 
intermediary between a System Manager (SM) and the Delivery Managers (DM) which 
supplies water to individual Land Managers (LM).  

The AM manages one or more water accounts.  Each of these accounts is associated with 
a particular SM and has a specified maximum volume.  An AM may have accounts with 
multiple SMs and more than one account with the same SM.  The AM is responsible for 
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managing the use of its accounts during a simulation.  There are two account utilization 
mechanisms in LAWS.  In a sequential utilization operation, the highest priority account 
is used completely before water from the next highest priority account is delivered from 
reservoir storage.  In a balanced utilization operation, water from each account is utilized 
simultaneously in a user specified proportion.  If an account is completely utilized before 
the simulation is complete, the balanced utilization ratios are recomputed to reflect the 
relative weighting of the accounts that still have remaining water supplies. 

Although the SM determines the actual daily amounts of water released from an AM 
reservoir account, the AM is responsible for establishing the amounts of the groundwater 
pumping and drain water reuse to be used to meet consumptive use requirements within 
its DM sub-regions.  In LAWS, the total volume of ground water use is not absolutely 
constrained to a specified amount.  However, the amount of drain water recycling is 
limited to a user specified fraction of the total drain water inflow during each time step. 
These user specified factors represent the percentage of the total consumptive use 
requirement that is to be met from these sources of supply.  The groundwater pumping 
and drain water reuse factors are set by the user for each DM in the AM region at each 
time step.  In the event that the amount of drain water available for recycling is not 
sufficient to meet the AM target, groundwater pumping is automatically increased to 
make up for the deficit.  Since the groundwater pumping and recycling factors may be set 
to zero by the user, alternative simulations using only reservoir supplies may be readily 
performed for comparison with various pumping and drain water recycling alternatives.  

The AM is responsible for establishing the water delivery priorities that are to be 
implemented within its region.  LAWS employs a user specified hierarchical system to 
determine how water is delivered to individual LM within a DM sub-region.  The 
application delivery logic is designed to be user extensible so that multiple factors such as 
seniority of water rights, types of crop, growth stage, moisture stress or other user defined 
criteria could be employed in the delivery decision logic in future versions of the model. 

 The AM is responsible for managing the DMs within its region.  At each time step, the 
AM must determine how much water to supply to each of its DMs.  After receiving 
deliveries for each of its accounts from one or more SMs, the AM may use one of three 
different delivery priority mechanisms.  In a sequential delivery operation, each DM is 
given a fixed priority relative to the others in the AM region and the highest priority 
DM’s consumptive use requirement is completely satisfied before water from the next 
highest priority DM is delivered.  In a balanced delivery operation, delivery is made to 
each DM in a user specified proportion.  In hierarchical delivery operation, deliveries are 
to each DM based on the priority of individual LMs within the DM.  This mechanism 
essentially treats all DMs with equal priority but insures that LMs meeting the highest 
ranking in the highest hierarchical level are completely satisfied before lower priority 
water deliveries are made.  If a ranking is reached for which the remaining water supply 
is inadequate, a shortage delivery is made to the LMs in this ranking group. 

At each daily time step, the AM is responsible for receiving and accumulating the 
requests for water supplies from each of its DMs.  Using this request information, the 
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AM employs its account utilization methods to determine how much water to request 
from its various accounts.  The amounts of requests are adjusted to account for 
conveyance depletions/accretions and forwarded to the SMs associated with each of its 
accounts. 

Delivery Manager 
Within the overall structure of LAWS, the Deliver Manager serves as an intermediary 
between the Land Manager (LM) whose function is to apply water to an individual land 
unit and the Area Manager (AM) that requests and distributes water received from the 
System Manager (SM).  Each DM is associated with a single AM and operates to meet 
requests for water from multiple LMs.  

At each time step, the DM is responsible for accumulating the amounts of water 
requested by each of its LMs.  After all the LMs’ application requests have been 
received, the DM has the responsibility for determining an appropriate amount of water 
to request from its AM to meet the needs of all the land units within its sub-region. 

In order to determine the amount to request, the DM takes into account a number of 
physical and management factors impacting water use within its sub-region.  The 
physical factors include conveyance losses from canals, inflows and outflows associated 
with adjacent DM sub-regions, deep percolation to groundwater, as well as various 
inflows and outflows from drains.  Management factors include the desired amount of 
groundwater pumping and drain water reuse within the DM’s sub-region. The water 
budget components of the DM system are shown on the Figure 3 below. 
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Figure 3 Delivery Manager Water Budget Components 
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It is important to recognize that the canals and drains within a DM sub-region are not 
explicitly represented as physical features within a LAWS model.  The DM canals and 
drains represent the affect of field scale canals and drains on the overall water budget 
within the sub-region.  This approach allows simulation of a sub-region’s water balance 
without the difficult and time consuming task of explicitly accounting for all field-scale 
infrastructure typically found in a water delivery system.  At the same time, this approach 
allows users ample flexibility to investigate the important effects these features exert on 
the amount the water needed to meet consumptive use requirements. 

During each time step, the three major functions of a DM are to deliver to the LMs the 
water received from the AM, receive water application requests from LMs and determine 
an appropriate amount of water to request from the AM in the next time step.  It is 
important to recognize that the actual amounts of water received from the AM for 
delivery to the LMs may be less than the amount requested.   

At each time step, the AM establishes the deliver priorities within its region and notifies 
each DM of the supply available for delivery.  The total amount consists of reservoir 
releases, groundwater pumping, and recycled drain water.  Using the delivery priorities 
established by the AM, the DM delivers water to all the LMs for which sufficient supply 
is available.  

 As the DM delivers water, LMs inform the DM of any unmet water needs by making an 
application request for whatever amount is still required for consumptive use based on 
the final soil water content after delivery to the land unit.  Once all the possible deliveries 
have been made, the DM queries the remaining LMs to determine their application 
requests.  This process insures that every land unit is queried and results in the soil water 
content and other water budget components of every land unit being updated at every 
time step. 

After the DM has completed the delivery process, the total amount of all LM application 
requests is known.  The DM must now determine the total amount of water to request 
(DIV) for the entire sub-region.  This process involves accounting for gains, losses and 
reuse of water within the sub-region.  In addition to water supplied by the AM, other 
sources of supply to the DM sub-region include inflows into canals from adjacent sub-
regions (IOR) and groundwater pumping (GWP).  Other than consumptive use of applied 
water (CUAW), losses from the sub-region include canal seepage (CLS), drain seepage 
(DLS), and deep percolation (DP) to groundwater, evaporation from canals (CLA) and 
drains (DLA) to the atmosphere, outflows from drains to adjacent sub-regions (DOR) and 
return flow from DM drains to AM drains (DRTN).  Tail water losses (TWL) and drain 
water reuse (DWR) within the DM’s sub-region are other user defined management 
factors that affect the amount of water the DM requests from the AM. 
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Land Manager 
Within the overall structure of LAWS, the role of the Land Manager (LM) is to apply 
water received from the Delivery Manager (DM) to the land, determine the soil moisture 
content after application and request an appropriate amount of water from the DM 
depending on the status of the soil water content.   
 
In LAWS V2, soil water flow is simulated using a 1-dimensional 2 layer model to 
calculate bare soil evaporation, plant transpiration, surface water runoff, infiltration, 
groundwater table upflux, and deep percolation.  Infiltration into the soil profile is 
simulated using a 1-dimensional unsaturated flow analytical equation.  Soil evaporation 
and plant transpiration are computed using the well known dual crop coefficient method. 
Upflux and deep percolation are also computed by accounting for the effects of variable 
saturation in a dynamically changing root zone. These results are used to determine the 
soil moisture content at each daily time step.  When the soil moisture is reduced to a user 
specified management allowable depletion, the LM notifies the DM that delivery of 
additional water is required.  Since certain crops and management practices require 
ponding of water on the soil surface, a provision is made to manage water under both 
ponded and unponded conditions. The effects of irrigation on changes in a non-reactive, 
conservative constituent can also be simulated. The details of these calculations are 
provided in the Technical Reference section of this report. 
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Walkthrough 
The following sections contain basic instructions on setting up, running, and viewing 
results of a LAWS Model.  Use the Walkthrough to get familiar with the application and 
its components.  The outline below is intended as a quick reference.  The blue text 
indicates that there is more detailed information on a particular subject available in this 
document if needed.  The use of the groundwater modeling capability in LAWS has been 
left out of this introductory discussion.  Interested users are urged to read the detailed 
discussion provided in the Technical Reference section.   
 
By design, the LAWS Project Tree reflects the dependencies and order in which data is 
usually created.  Starting at the top of the tree is the Project node.  This, is the starting 
point of the process.  After a project is created, maps are added. Notice that Map node is 
directly under the Project node.  The flow of data creation does not have to remain in this 
order.  Although, it is the recommended order because there are dependencies between 
some objects which require a preceding object to be referenced by a subsequent object 
when it is created.   
 
The following outline presents the steps in creating a LAWS model.  More detailed 
information follows it. 
 
Setting up the Initial Data: 

• Creating a Project  
• Adding Maps 
• Selecting model units 
• Creating a Stream Alignment 
• Entering Global Data 

 
Creating the Modules: 

• Land Module 
• Land Managers 
• Editing the Land Manager Data 

• Crop Management Modules 
• Editing the Crop Management Module Data 

• Flow Network Module 
• Creating a Reservoir 
• Editing a Reservoir 
• Creating a Reach 
• Editing a Reach 

• Atmospheric Module 
• Creating a Met Station 
• Editing a Met Station 

• Water Management Module 
• Creating an Area Manager 
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• Editing an area Manager 
• Creating a System Manager 
• Editing a System Manger 
• Creating a Delivery Manager 
• Editing a Delivery Manager 

 
Bringing it all Together: 

• Creating an Alternative 
• Editing an Alternative 

• Run the Alternative 
• View the Results 

 
 

Initial Data 
Creating a Project 
 
The first step in starting the process of using LAWS is to create a new Project.    
 

1. Select New… from the File menu.   
2. In the New… dialog select Project from the list and click Next.   
3. The New Project dialog will display like the one pictured below.  Give the 

project a name and description.  Select a directory you would like the project to 
reside in by clicking the ellipse button  within the Directory text field.  The 
Unit System will always be set to English and these are the units in which all 
calculations are made.  However, there is the option to switch all input and output 
data to metric.  This is discussed below.  A Project directory will be created using 
the name given.  All Project related files and directories will reside in this main 
directory.  The Project's node will appear at the top of a Project Tree in the Project 
Tree Pane.  The tree will also fill with data nodes and open an empty Map 
Schematic. 
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Adding a Map 
 
Maps may be imported into the Project by adding them via the map context menu.   
 

1. Right-click on the Map Node in the Project Tree and select Add Maps.   
2. Traverse to the desired maps using the file browser.   
3. Select the Create Copy check box located on the right side of the dialog to copy 

the map files to the Project’s directory.   
4. Click OK. 

 
The Map Schematic window will expand by default to show the total map extents of the 
maps added.  However the map extents can be changed manually through the Default 
Map Properties editor located in the Project menu.  Use this editor to confirm that the 
proper map units are being used.  
 
The following is a list of supported map types: 
 

• DLG (USGS Digital Line Graphs) 
• SHP (ArcView shapefiles) 
• DXF (AutoCAD Digital Exchange Format) 
• DEM (USGS Digital Elevation Models) 
• IMG (Raster Image) 
• ASC (ArcInfo ASCII grid) 
• NET (ASCII NetTIN) 

 
Next Step in the Walkthrough - Creating a Stream Alignment 
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Selecting Model Units 
All LAWS calculations are made using English length units (feet), however, users 
wishing to use SI units for input and output data can do so.  To change the system of 
units, the user should go to View - Unit System and select the preferred system. 
 

Creating a Stream Alignment 
 

 
 
A Stream Alignment is a visual representation of the stream system modeled. With or 
without a map, a Stream Alignment will need to be created or imported.   
 
Create a New Stream Alignment 

1. Right-click the Stream Alignment Node  in the Project Tree and select New... 
from the popup menu. 

2. In the New Stream Alignment dialog, enter a Name and Description, then click 
OK.   

 
Stream Alignment Tools will be added to the current Map Schematic.  A new Stream 
Alignment Node with the given name will appear under the main Stream Alignment 
node.  If a Map Schematic is not opened, the creation of the stream alignment will open 
one automatically.  Note that the newly created Stream Alignment name is shown in the 
Project Tree with bold type, indicating that it is displayed in the active Map Schematic 
window. 
 
Drawing a Stream Alignment 

1. Select the Stream Alignment Tool   from the tool bar along the left side of the 
Map Schematic*.  

2. Hold down the Ctrl key and click with the left mouse button to place successive 
points along the stream alignment.   

3. To terminate the stream element, release the Ctrl key and click to place the last 
point of the stream.  
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Editing a Stream Alignment  
 

1. To delete extra points on the stream alignment left-click on the point while 
holding down the Ctrl and Shift keys**.  To add points, holding down the Ctrl 
and Alt keys and click on the Stream Alignment's line.  

 
*The Stream Alignment must be created from upstream to downstream.  
**Be sure the Stream Alignment is selected.  If it is selected, the points will be colored 
blue. 
 
 
Next Step in the Walkthrough - Creating Global Data 
   

Creating Global Data 
Global Data represents the collection of tangible information used to create the 
management components of the LAWS alternatives.  They do not have graphic 
representations on the Map Schematics.  The data are divided into five categories.  
 

1. Crop Types 
2. Irrigation Types 
3. Soil Types 
4. Crop Schedules 

 
Next Step in the Walkthrough - Adding Crop Types 
 

Adding Crop Types 

1. Double click on the Crop Types Node  in the Project Tree.   
2. In the Crop Types Editor create a new Plant Type by selecting New in the Crop 

Type menu.  
3. Give the new Crop Type a Name and Description and click OK*.   
4. The editor will fill with the new Crop Type.     
5. Enter the Early and Late Planting Dates using the Calendar Tool accessed by 

the ellipse buttons  in the text fields.   
6. Fill out the Growth Stage table and click OK.   

 
Repeat filling the editor for each Crop Type created.  For more detailed descriptions see 
the LAWS Help section on Crop Types. 
 
Next Step in the Walkthrough - Adding Irrigation Types 
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*It's recommended that you use names that clearly identify the crop type.  For example, if 
the crop is corn, name the Crop Type "Corn".  If more than one type of corn will be used, 
use names like "Dent Corn" and "Sweet Flint Corn". 
 

Adding Irrigation Types 
1. Double click the Irrigation System Types Node  in the Project Tree. 
2. In the Irrigation System Editor click in the first empty row in the Type column. 

  
3. The editor will be filled with default Irrigation Types.  However, you can add 

additional Irrigation Types by first selecting the last row's Type column.  This 
will automatically add a row to the table.   

4. Fill in the table values for your new Irrigation Type.  
5. Continue adding Irrigation System Types needed for the model. 
6. Click OK to save the changes and close the editor. 

 
For more information see the LAWS Help section on Irrigation System Types. 
 
Next Step in the Walkthrough - Adding Soil Types 
 
*Remember to use a meaningful name that describes the irrigation being represented, 
i.e., "Sprinkler", "Flood", "Furrow".    
 

Adding Soil Types 
1. Double click on the Soil Type Node  in the Project Tree.   
2. In the Soil Types Editor create a new Soil Type by selecting Soil Type -> New... 

  
3. Give the Soil Type a Name* and Description, then click OK.   
4. In the editor, at a minimum enter the percent values for the soil's three texture 

types: Sand Content, Silt Content, and Clay Content and the evaporation layer 
thickness and the readily evaporable water (REW).  The combined total of the 
texture percentages must equal 100.  You can also add values for the Bulk 
Density, Theta_s, and Ksat, but these are not mandatory.  

5. Once you have entered the data and the three content's values total 100, click the 
Apply button to calculate the van Genuchten parameter values.  

6. When you are done adding Soil Types, click OK to close the editor and save the 
information.   

 
For more detailed information on the Soil Type editor, see the Soil Types Help section. 
 
Next Step in the Walkthrough - Adding Crop Schedules 
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* Try to use names that clearly identify the type of soil modeled, i.e., "Sand","Clay".  

Adding Crop Schedules 
 

1. Double click the Crop Schedule Node  in the Project Tree.  
2. In the Crop Rotation Editor select Crop Schedule  -> New.... 
3. Give the schedule a Name and Description then click OK.   
4. In the Crop Rotation Editor fill in the table with planting events, choosing from 

the Crop Types created earlier.   
5. Fill in the Year and planting Date for each event.    
6. When you are done adding schedules, click the OK button. 

 
If the time period of the schedule does not fully encompass a simulation period, the 
schedule is repeated (both into future and past as necessary).  
 
See Crop Schedule for more information.   
 

Creating Modules 
Land Module 

Creating a Land Module 

 
 

1. To create a Land Module right-click the Land Modules Node  in the Project 
Tree and select New... from the context menu.   

2. A New dialog will appear.  Give the Land Module a Name and Description, then 
click OK.   

 
A new Land Module Node   will appear under the Land Modules Node in the Project 

Tree.  The Land Manager Tool  will be added to the toolbar on the current Map 
Schematic.  Use this tool to create graphical representations of Land Managers (fields) on 
the map.   
 
Next Step in the Walkthrough - Creating Land Managers  
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Creating a Land Manager 

1. First select the Land Manager Tool  in the Map Schematic*.   
2. While holding down the Ctrl key, left click in the Map Schematic window were 

you would like to place the first point.   
3. Continue creating the outline of the field shape by left clicking points on the map. 

  
4. For the final point, release the Ctrl key and click**.   
5. The outlined area will be filled in with yellow, indicating it is selected, otherwise 

it will appear green.   
 
Next Step in the Walkthrough - Editing Land Manager Data 
 
*A Land Module must be created first or set active in the Map Schematic. 
**Be sure to create an enclosed area and not overlap the outline on itself.   
 

Editing a Land Manager 

1. Right click on a Land Manager  in the Map Schematic and select Edit from its 
context menu*.   

2. The Land Manager editor will appear with the selected field information 
displayed.   

3. Choose either Calculate Area or Enter Area.  If Calculate Area is chosen 
LAWS calculates the Land Manager area using the geometry of the Land 
Manager polygon.   LAWS can also be used to construct models that are not 
necessarily to scale by selecting the Enter Area option. 

4. Select the Land Use.  The choices are either Irrigated Field or Other Demands.  
Use the Other Demands option if a demand needs to specified as either a 
constant value or using a time series.  The Irrigated Field option calculates a full 
root zone water balance. 

5. If modeling water quality, enter the Initial Water Quality in ppm.  This 
represents the concentration of the modeled constituent in the soil water at the 
beginning of the simulation period.  This feature does not apply if Other 
Demands are being modeled. 

6. Select the Field's Irrigation System Type from the drop down list of previously 
created Irrigation Systems. 

7. Enter a value for the Drain Inflow Factor.  This represents the portion of deep 
percolation that enters the drains.  The remainder flows to the groundwater 
system.   

8. Enter a value for the Water Table Depth.  This value is used to calculate the 
amount of upflux from the water table.  If the groundwater modeling option is 
used this value will be calculated by LAWS. 
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9. Soils information can be entered as Soil Types or Soil Properties. The Soil Types 
option utilizes information entered in the Soil Type Editor.  The Soil Properties 
allows the direct entry of soil physical parameters.  Select what entry form you 
would like to use and fill out the information accordingly. 

1. Soil Types - A table will be available that allows you to select the one or 
more Soil Types from a list of previously created Soil Types.  Each Soil 
Type selected requires a percent value that represents the portion of the 
Land Manager that contains the chosen soil type.  Once the percentages 
are entered, the Soil Property Input Values data and van Genuchten 
properties will be calculated. 

2. Soil Properties - The Soil Properties selection allows the manual entry of 
Soil Property Input Values or the Van Genuchten Parameters.  Simply 
select which way you would like to enter the values using the radio 
buttons next to the input types listed.  Then enter the values in the editable 
fields. 

 
Next Step in the Walkthrough - Creating a Cropping Plan 
 
*A Land Module must be open in the Map Schematic. 
 

Crop Management Module 

Creating a Crop Management Module 
 

1. Right click the Crop Management Modules Node  in the Project Tree and 
select New.. from the popup menu. 

2. The New dialog will display.  Enter a Name and Description for the Crop 
Management Module.   

3. Select a Land Module for the Crop Management Module from the Land Module 
drop down list of previously created Land Modules.   

4. Click OK.   
 
A new  node with the name of the created Crop Management Module, will appear 
under the Crop Management Modules Node.   
 
Next Step in the Walkthrough - Editing Crop Management Modules 

Editing a Crop Management Module 

1. Right click the individual Crop Management Modules Node  in the Project 
Tree and select Edit from the popup menu.   

2. The Crop Management Module Editor will appear.   
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3. Select Crop Schedules for each Land Manager listed in the table.   
4. Click OK to save the changes and close the editor. 

 
Next Step in the Walkthrough - Creating a Flow Network Module 
 

Flow Network Module 

Creating a Flow Network 
 

 
 

1. Right-click the Flow Network Module Node  in the Project Tree and select 
New... from the popup menu.   

2. In the New dialog enter a Name and Description for the new Flow Network.   
3. Select a Stream Alignment for the Flow Network and click OK.  

A new Flow Network Node  will be created under the Flow Network Module Node. 
 Flow Network tools will be added to the toolbar in the current Map Schematic. 
 
Next Step in the Walkthrough - Creating Reservoirs 
 

Creating a Reservoir 

1. Select the Reservoir Tool    in the Map Schematic*.   
2. While holding down the Ctrl key, left-click the upstream area of the Stream 

Alignment you would like to place the starting point of the reservoir.  
3. Release the Ctrl key and click the Stream Alignment were the Reservoir will end. 

 
The cyan colored Reservoir will draw between the points.  A triangle  will be drawn 
at the downstream end.  This triangle is the Reservoir's pool.  The pool shape can be 
changed.  To learn more, see Drawing Reservoirs. 
 
Next Step in the Walkthrough - Editing the Reservoir Data 
 
*A Flow Network must be opened in the current Map Schematic. 
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Editing Reservoir Data 
1. Right-click on the Reservoir in the current Map Schematic and select Edit 

Reservoir from the popup menu*.   
2. In the Reservoir Editor enter values for Maximum Conservation Storage and 

Instream Flow Requirement.  If the time series option is selected then a time 
series must be chosen in the Alternative Editor (see below). 

3. Choose a Release Capacity Option from the option's dropdown list.   
1. If Constant is chosen for the release, enter a Maximum Release 

Capacity.   
2. If Time Series is chosen, a time series of release rates will need to be 

specified in the Alternative Editor. (See that section for more detail.) 
4. Click OK to save the changes and close the dialog.   

 
Next Step in the Walkthrough - Creating a Reach 
 
*A Flow Network containing a Reservoir must be opened in the current Map Schematic. 

Creating a Reach 

1. Select the Reach Tool  in the Map Schematic. 
2.  While holding down the Ctrl key, click where the Reach will begin on the 

Stream Alignment.  
3.  Release the Ctrl key and click the Stream Alignment to place the end point of the 

Reach.   
 
The points will become red Junctions , unless the Reach was ended or started at a 
Junction.  In this case the Reach will use the existing Junctions.  The area between the 
points, along the stream alignment, will fill with the new Reach.   
 
 
Next Step in the Walkthrough - Editing Reach Data 
 

Editing Reach Data 
1. Right-click the Reach and select Edit Reach from the popup menu.   
2. The Reach Editor will appear.  Within this editor the Travel Time and Channel 

Losses can be changed.   
 
Next Step in the Walkthrough - Creating an Atmospheric Module 
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Atmospheric Module 

Creating an Atmospheric Module 

 
 

1. Right-click on the Atmospheric Modules Node  in the Project Tree and 
selecting New... from the popup menu.   

2. The New Atmospheric Module dialog appears.   
3. Give the Module a Name and Description. 
4. Click OK.    

The new Atmospheric Module Node , with the given name, will appear under the 
Module's node.  A Met Station Tool  will be added to the current Map Schematic's 
Toolbar.   
 
Next Step in the Walkthrough - Creating Met Stations 
 

Creating a Met Station 

1. Select the Met Station Tool  in the Map Schematic* 
2. Hold the Ctrl key down and click on the area you would like to place a Met 

station.   
 
Next Step in the Walkthrough - Editing Met Station data 
 
*An Atmospheric Module must be open in the current Map Schematic 

Editing a Met Station 

1. Select the Met Station Tool  in the Map Schematic*. 
2. Right-click the Met Station and select Edit Met Station.   
3. In the Met Station Editor, select the Regional type you need.   

1. If using Radial, a Radius value will need to be entered.   
2. To display the extent of Met station's influence, choose the Map tab on the 

Project pane and expand the Atmospheric Module branch.  Check the 
Coverage Area to display the extent of the Met station's influence.   

4. If water quality is being modeled, a rainfall water quality concentration will need 
to be entered.  The user can select either a constant water quality value or a Time 
Series Water Quality which will need to be referenced in the alternative editor. 
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5. Click OK to save the changes and close the editor 
 
Next Step in the Walkthrough - Creating a Water Management Module 
 
*An Atmospheric Module must be open in the current Map Schematic 
 
 

Water Management Module 

Creating a Water Management Module 

 
 

1. Right-click the Water Management Node  in the Project Tree and select 
New... from the popup menu. 

2. The New Water Mangement dialog appears.  Give the module a Name and 
Descritpion. 

3. Click OK. 
 
A new Water Management Node  will appear under the module node.  The Delivery 

Manager Tool will be added to the current Map Schematic window. 
 
Next Step in the Walkthrough - Creating an System Manger 
 

Creating a System Manager 
1. Right-click on a Water Management Node and select Edit -> System Manger 

from the context menu.   
2. The System Manager Editor will appear.  In the System Manager menu select 

New....   
3. A Create System Manger dialog will appear.   
4. Give the new System Manager a Name and Description then click OK.   

 
The editor will fill with the new System Manager's information.  
 
Next Step in the Walkthrough - Editing a System Manager 

Editing a System Manager 
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1. Right-click on a Water Management Node and select Edit -> System 
Manger from the context menu.   

2. The System Manager Editor will appear. Select a Flow Network from the 
dropdown list of previously created Flow Networks.   

3. Add Reservoir Accounts using Reservoirs contained in the Flow Network.   
4. Select the Add Account button on the Reservoir Account tab.  A  New 

Reservoir Account dialog will display.   
5. Give the Account a Name and Description then select the Reservoir from the 

Reservoir dropdown list.   
6. Click OK to create the Account.   
7. The new Account will appear in the Account table.   
8. Enter the % Conservation Storage.  
9. Select whether the reservoir storage will use Balanced or Sequential Allocation 

using the Usage radio buttons.  
10. Click OK to save the changes and close the editor. 

 
Next Step in the Walkthrough - Creating an Area Manager 

Creating an Area Manager 

1. Right-click the Water Manager Node  and select Edit -> Area Manager from 
the popup menu. 

2. In the Area Manager Editor select Area Manager -> New.  The New Area 
Manger dialog will display.   

3. Give the new manager a Name and Description then click OK.   
4. The editor will fill with the new Area Manger's default data.   

 
Next Step in the Walkthrough - Editing an Area Manager 
 

Editing an Area Manager 

1. Right-click the Water Manager Node and select Edit -> Area Manager from 
the popup menu. 

 
Creating a Water Account 
 

1. On the Water Account tab in the Area Manager Editor, create a new Water 
Account.   

2. Select the Add Account button.  The New Water Account dialog will display.   
3. Give the Account a Name and Description. 
4.  Select the System Manager from the System Manager dropdown list.   
5. Click OK to create the Account.  The new Account will display in the Account 

table.   
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6. Enter a Max Yearly Volume for the Account. 
 
 
Next Step in the Walkthrough - Creating a Delivery Manager 

Creating a Delivery Manager 

1. Select the Delivery Manager Tool  on the Map Schematic Toolbar*.    
2. While holding down the Ctrl key, click in the Map Schematic where you would 

like to place the first point.**   
3. Continue creating the outline of the polygon by clicking points on the map.  Be 

sure to only encompass Land Mangers in only one Delivery Manager Area.  
4. For the final point, release the Ctrl key and click near or on the first point.  Be 

sure to create an enclosed area and not overlap the outline on itself.   
5. A dialog will appear prompting you to give the Manager a Name, Description, 

and assign it an Area Manager.   
6. Click OK.   

 
The outlined area will be filled in with yellow, indicating it is selected, otherwise it will 
appear blue.  Create as many Delivery Managers as needed for the Area Manager. 
 
Next Step in the Walkthrough - Editing Delivery Managers 
 
*A Water Management Module must be open in the current Map Schematic. 
** Be careful not to overlap existing Delivery Managers! 

Editing a Delivery Manager 

1. Select the Delivery Manager Tool  on the Map Schematic Toolbar*.    
2. Right-click on a Delivery Manager and select Edit Delivery Manager from the 

popup menu.  
3. The Delivery Manger Editor will appear. 
4. Changes to the Connectivity, Physical and Management Parameters can be 

made.   
 
Next Step in the Walkthrough - Creating an Alternative 
 
*A Water Management Module must be open in the current Map Schematic. 
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Bringing It All Together 
Alternatives are where all the pieces of the LAWS model come together.  The physical 
and biological characteristics, infrastructure and system management pieces previously 
created can be combined together in various combinations to evaluate their effects on 
system operations. 
 

Alternatives 

Creating an Alternative 

1. Right-click the Alternative Node  in the Project Tree and select New... from the 
popup menu.  The New Alternative dialog will appear.   

2. Give the Alternative a Name and Description.  Then click OK.  
 
The new Alternative's node  will be created under the main Alternative Node. 
 
Next Step in the Walkthrough - Editing the Alternative 
 

Editing an Alternative 

1. Right-click an Alternative Node  and select Edit from the popup menu. 
 
Selecting Modules 

1. On the Module tab of the Alternative Editor select the Modules you would like 
the Alternative to use*.  
    

*If needed, New Modules can be made using their corresponding New button. 
 
Run controls 
 

1. On the Run Controls tab enter the Start and End Date for the Alternatives 
computation period.   

2. Choose if water quality should be simulated.  A description of the LAWS water 
quality algorithm is provided in the Technical References section. 

3. Choose whether to Write Land and Delivery Managers ASCII Output File**. 
   

 
**This option is available because large numbers of Land Managers (Fields) can create 
large files. 
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Initial conditions  
 

1. Enter the required initial condition values.   
 
Input Time-Series 
 

1. On the Time-Series tab, DSS files need to be assigned to the Met Stations and 
any other options where DSS data inputs have been selected. 

2. Click on a row in the table. 
3. Select the Browse DSS Paths button. 
4. A Time Series browser displays. 
5. In the browser, select the dss path from the list 
6. Click the Set Pathname button to assign the path to the selected Met Station row. 

7. Close the Browser using the  button in the upper right-hand side of the 
dialog. 

8. The Met Station row will display the selected pathnames chosen 
9. Click OK to save the changes and close the Alternative Editor 

 
Next Step in the Walkthrough - Running an Alternative 

Running an Alternative 

There are two ways to start the compute of an Alternative.   
 

1. Select Simulation -> Compute Alternative from the main menu bar. 
2. Right-click the Alternative's node and select Compute from the popup menu. 

 
Once the Alternative starts computing, a compute progress bar will display.  A compute 
message tab, using the Alternative's name, will be added to the Message Pane area.  
 
Next Step in the Walkthrough - Viewing Results 

View Results 
Results can be viewed using the following formats: 
 

• Plots - Model output can be viewed by right-clicking on the object of interest and 
selecting the desired plot.  These are available for Land Managers, Delivery 
Managers, Reservoirs, and Reaches.  Within the plot window the Tabulate menu 
item can be selected to view the data in tabular format. 
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Interface  

Main Window 
 
When LAWS is opened for the first time, the Main Window below is displayed. The 
components of the Main Window are shown on the figure below and described in the 
subsections below. 
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Menu Bar 
Along the top of the Main LAWS Window resides the Menu Bar.  The Menu Bar allows 
for quick access to data information and editing additionally done through the Project 
Tree editors.  It also gives access to viewing results, creating and saving information, and 
customizing the look and feel of the application.  Helpful tools, such as DssVue and the 
LAWS Help documentation are available here as well.  The Menu Bar includes the 
following options: 
 

• File  
• Edit 
• View 
• Project 
• Simulation 
• Results 
• Tools 
• Window 
• Help 

 
 
In the tables that follow, the functionality associated with each of these options is 
described and keyboard shortcuts are presented.  Please note that some of the tables 
extend over several pages. 
 

File Menu 
File menu commands: 
 

Name Function Keyboard 
Shortcut 

New New selector dialog.  Within this dialog, depending on what is 
selected in the Project Tree, you can select to create the following: 

Project 
Stream Alignment 
Flow Network Module  
Land Module  
Atmospheric Module  
Alternative  
Water Management Module 
Cropping Plan 

Ctrl + N 
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Open Open selector dialog.  Within this dialog, depending on what is 
selected in the Project Tree, you can select to open the following: 

Project 
Stream Alignment 
Flow Network Module 
Land Module 
Atmospheric Module 
Alternative 
Water Management Module 
Cropping Plan 

Ctrl + O 
 

Open 
Project  

Open an existing Project  
 

 

Save 
Project 

Save the current Project 
 

 

Save 
Project 
As 

Copy and save the current project with a new name.  
 

 

Close 
Project  

Close the current Project 
 

 

Open 
File in 
Project 

Open a selected file within a Project by selecting the file using the 
file selector dialog shown above. 
 

Ctrl + Shift + 
O 
 

Save Save a file in the current Project.  Saves the file associated with the 
highlighted item in the Project Tree 
 

 

Save 
As 

Copy and save the current file associated with the selected item in 
the Project Tree.  A new name will be requested for the file.  The 
new item will appear within the Project Tree 
 

 

Rename Rename the current file associated with the selected item in the 
Project Tree 
 

 

Delete Delete the current file associated with the selected item in the 
Project Tree and removes its tree node if applicable  
 

 

Save 
Map 
Image 

Save the current Map Image within the Map Schematic 
 

 

Page 
Setup 

Currently not available.  
 

 

Print  Print the file associated with the currently selected item within the 
Project Tree 
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Reopen  Reopen a previously opened project from a provided list of 
Projects.  The list of Projects to select from will appear in a menu 
to the right of the Reopen menu.  If no Projects have been opened 
previously, the list will not appear 
 

 

Exit Exit and close the LAWS Application 
 

 

 

Edit Menu 
Edit menu commands: 
 

 

Name Function Keyboard 
Shortcut 

Undo  Undo the last editing change made 
 

Ctrl + Z 

Redo Redo the last Undo change 
 

Ctrl + Y 

Cut  Remove selected information and store it to the clipboard.   
 

Ctrl + X 

Copy Copy selected information and store it on the clipboard.  
 

Ctrl + C 

Paste Paste information from the clipboard to the current cursor 
location.   
 

Ctrl + V 

Global Data Displays an additional menu that contains a list of all Global 
Data types that can be edited in the current project.  Each item 
in the list will display the corresponding editor for the 
following 
 

• Crop Types 
• Irrigation System 
• Crop Rotations 
• Water Rights 

 

 

Land 
Modules 

Displays the Land Module Editor filled with the current 
project's Land Module data 
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Crop Plan Displays the Crop Plan Editor filled with the current project's 
Crop Plan data 
 

 

Flow 
Network 

Displays an additional menu option which contains a list of 
Flow Network.  
 

• Reservoir 
• Reach 
• Junction 

 
Each item in the list will display the corresponding editor.  
 

 

Atmospheric 
Data 

Displays the Atmospheric Data Editor filled with the current 
project's Atmospheric data  
 

 

Water 
Management 
 

Displays an additional menu option that contains a list of 
Water Management types in the current project.  
 

• Delivery Manager 
• Area Manager 
• System Manager 

 
Each item in the list will display the corresponding editor. 
 

 

Alternative Displays the Alternative Editor filled with the current projects 
alternatives. 
 

 

 

View Menu 
View menu commands: 
 

Name Function Keyboard 
Shortcut 

Toolbars Allows you to display either  the Standard tool bar, the Clipboard 
tool bar, or both just below the menu bar 
 

 

Project 
Pane 

When checked, displays the Project Pane 
 

 

Messages When checked, displays the Message Pane 
 

 

Status When checked, displays the Status Pane  
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Toggle 
Views 

Toggle the view between displaying the Map Schematic at  full 
screen or current screen view setting 
 

Ctrl + T 

Unit 
System 

The unit system used within the Projects.   
 

 

Save 
Layout 

Save the current layout  
 

 

Restore 
Layout 

Restore a layout from a list of saved layouts 
 

 

Layout 
Manager 

Currently not available 
 

 

Zoom to 
All 

Zooms in to all open Map Schematics 
 

 

 
 

Project Menu 
Project menu commands: 
 

Name Function Keyboard 
Shortcut 

Project 
Properties... 

Displays the Project Properties dialog which contains 
information on the current project 
 

 

Default Map 
Properties 

Displays the editor for the Default Map Properties. 
 

 

Archive 
Project 

Currently not available  
 

 

Add Map 
 

Add a map to the currently selected Map Schematic 
 

 

Import Import Stream Alignments 
 

 

Export Export a Stream Alignment 
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Simulation Menu 
Simulation menu commands: 
 

Name Function Keyboard 
Shortcut 

Compute 
Alternative 

Starts the currently selected Alternative's compute 
 

 

Compute 
Manager 

Currently not available 
 

 

 

Results Menu 
Results menu commands: 
 

Name Function Keyboard 
Shortcut 

View Water 
Balance 
Summary 
 

Display the Water Balance Summary for the currently 
selected Alternative 
 

 

View Account 
Volume 
Summary 
 

Display the Account Volume Summary for the currently 
selected Alternative 
 

 

View Delivery 
Manager 
Output 
 

Display the Delivery Manager output for the currently 
selected Alternative 
 

 

View Land 
Manager 
Output 
 

Display the Land Manager output for the currently selected 
Alternative 
 

 

Land 
Module 
Display 
Properties 
 

Display the properties editor for the current projects Land 
Modules 
 

 

Animate 
Results 
 

Animates the computed data through the entire Alternative 
compute time window 
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Tools Menu 
Tool menu commands: 
 

Name Function Keyboard 
Shortcut 

Scripts... Accesses a Jython Script editor.  Currently not available 
 

 

HecDssVue 
Displays the HEC application HecDssVue for viewing dss files 
 

 

Options... Displays the Options dialog for the application 
 

 

Customize... Displays the Customize dialog for the application 
 

 

Memory 
Monitor 

Displays the Memory Monitor for the application 
 

 

 

Window Menu 
Window menu commands: 
 

Name Function Keyboard 
Shortcuts 

New Map 
Window 

Opens a new map window in the Map Schematic area 
 

 

Map 
Window 
Properties 

Displays the properties dialog for the current map windows 
 

 

Tile  Display all open map windows in the form of tiles within the 
Map Schematic area 
 

 

Cascade  Display all open map windows in a cascade from left to right 
within the Map Schematic area 
 

 

Next 
Window 

Brings the window behind the current window forward and to 
the front of all map windows in the Map Schematic Area 
 

 

Previous 
Window 

Brings the previously viewed window forward and to the front of 
all map windows in the Map Schematic Area 
 

 

Window Displays a dialog which allows you to select which window you  
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Selector would like to see display up front 
 

Window Allows you to select the window to bring up front form a list of 
open windows in a menu 
 

 

 

Help Menu 
Help menu commands: 
 

Name Function Keyboard 
Shortcut 

Help Displays the main Help documentation for LAWS 
 

 

What's 
This 

Sets the cursor into a "What's This" mode.  Any item the cursor 
clicks on will then display any relative Help documentation on that 
item 
 

 

LAWS 
Web 
Site 

Displays your browser and loads the LAWS web site 
 

 

USBR 
Web 
Site 

Displays your browser and loads the USBR web site 
 

 

About 
LAWS 

Displays the About dialog on the LAWS application 
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Toolbar 

The Toolbar is located directly under the Menu bar.  The Toolbar is initially set to display 
two sets of tools, the Standard and Clipboard tools.  More tools can be added to the 
Toolbar through the Customize dialog accessed from the Tools menu.  Below is a table 
of all tools available and their function: 
 

Tool Name Function 

 New 
 

New selector dialog.  Within this dialog, depending on what is selected in 
the Project Tree, you can select to create the following: 

Project 
Stream Alignment 
Flow Network Module  
Land Module  
Atmospheric Module  
Alternative  
Water Management Module 
Cropping Plan 

 Open 
 

eOpen selector dialog.  Within this dialog, depending on what is selected in 
the Project Tree, you can select to open the following: 

Project 
Stream Alignment 
Flow Network Module  
Land Module  
Atmospheric Module  
Alternative  
Water Management Module 
Cropping Plan 

 Close 
 

Close the current project 

 Save 
 

Save the current project 

 Save All 
 

Save all changes made tot he current project 
 

 Print 
 

Print the associated data of the selected item in the current project 
 

 Undo 
 

Undo the last editing 
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 Redo 
 

Redo the Undo 

 Copy 
 

Copy the selected item to the clipboard 
 

 Paste 
 

Paste item from clipboard to the cursor location 
 

 
 

Cut Cut the selected item and copy it to the clipboard 

 Land 
Module 
Display 
Properties 

 

     Animate 
Results 
 

 
 

 
 
 

Project Tree 

The Project Tree is located on the upper left side pane of the Main LAWS Window. 
 Each branch in the Project Tree is called a Node.  Each Node represents different data 
components in the Project.  The Nodes are named after the data types they contain. For 
instance, the Maps node will contain Manager Nodes for each map added to the Project. 
 The Manager Nodes manage the data.  From Manager Nodes, users may view and 
manipulate the Project's data and information.   
 
Data are added to the Project following the Project Tree structure from top to bottom. For 
example, the first step in setting up a new Project is to add maps.  The Maps Container 
Node resides at the top of the tree.  The Nodes occur in the order that is recommended for 
building a LAWS model.  For example, when a Stream Alignment is added its Node 
occurs below the Maps Node. And so on.  The following is a list of available Nodes.  A 
description of each Node follows the list. 
 

• Project  
• Maps 
• Stream Alignments 

 
• Global Data 

• Crop Types 
• Irrigation System Types 
• Soil Types 
• Crop Schedules 
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• Land Module 
• Crop Management Module 
• Flow Network Module 
• Nonagricultural Land 
• Atmospheric Modules  
• Water Management Module 
• Alternatives 

 
 

Map Schematic Area 

The Map Schematic Area is the area of the application where Map windows display.  It is 
the large blue area located on the right side of the application window directly below the 
Toolbar. Multiple Map Schematic windows can be viewed within this area.  The format 
for viewing Map Schematic windows can be changed through the Window menu.  The 
Map Schematic area can be resized by selecting and dragging the panel's edges or by 
using the View menu Toggle View option. 
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Content Pane 

 
 
Located directly under the Project Tree area, the Content Pane displays information 
relating to the highlighted data object in the Project Tree.  In the case below, the data 
object is the Alternative, "Simple Alt".  The Content Pane displays information on that 
Alternative's data, which includes the Atmospheric Module (CIMIS), Land Module 
(Simple Land Use), Flow Network (Simple Network), and the Water Management 
Module (Simple Manager). 

File Tab 
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The Files tab displays the open Project's files.  The file tree layout is the same file 
structure you would see if you viewed the project files outside the application; for 
example if you used Windows Explorer.  However, the files displayed do not include all 
files used or created by the application. 
 

Map Tab  
 

 
 

The Map tab lists all open Map Windows in the top pane.  Selecting a particular Map 
Window from this list will display information on that Map Window's map layer data 
within the lower Content Pane.  

Map Layers: 
Map Layers are like transparencies laid one on top of the other, with static physical 
images such as roads, county and state boundaries, rivers, sub basins, etc., layered in the 
display as color pictures.  Each of these images, along with its associated data, is a 
layer.  The following are descriptions of the different Layers used in the LAWS 
application display.  These layers are available for editing through the Maps tab under 
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the Content Pane.  To remove a layer from the Map Schematic remove the check mark 
next to the layer's data name in the Map Layers tree, pictured above. 

 

• Atmospheric Module - Named   "CIMIS" above, the Atmospheric Module layer 
displays Met Station Icons,  in the Map Schematic Window. 

 

• Land Management Module - The Land Management Module displays Land 
Manager polygons,  as well as a legend. 

 

• Delivery Managers - The Water Management Module, "Simple Management" 
above, displays the Delivery Manager Polygons . 

 

• Flow Network - The Flow Network Layer, "Simple Network" pictured above, 
contains the following layer data representations of the river system modeled in 
the watershed: 

• Reservoir  

• Reach  

• Junction   

• Groundwater  

 

• Stream Alignment - The Stream Alignment Layer contains the Stream 
Alignment representing the river system in the watershed.  The Stream Alignment 
layer includes three component layers:   

 

• Stream Junctions  

• Streams  (also referred to as Stream Elements) 

• Stream Nodes  

•  

• Map - This application can display various types of maps and elements in the 
geo-referenced map display area.  These maps, displayed as map layers, are static 
physical images.  Examples of map layers include roads, county and state 
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boundaries, rivers, sub basins, etc.  Some maps are static images, which display as 
color pictures in the display area.  Map Layers are not interactive.  Instead, you 
interact with data associated with Schematic Elements you place in your map 
display. 

 

Message Pane 

The Message Pane displays information on actions that occur within the application. 
 These actions include, creating or loading data, computing an Alternative or displaying 
results.  For instance, if an alternative was computed, the Message Pane will create a 
Compute tab, which will contain the output information for the alternative.  If a new 
project was created, the Message Pane will display information about the project's 
creation on the Messages tab. The message would include the Project's file name, 
location, and whether it was created successfully.  Problem or error messages also display 
within the pane's tabs.   
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Editors 

The following is a list of Project Data Editors: 
 

• Global Data  
• Crop Types 
• Irrigation System Types 
• Soil Types 
• Crop Rotation Types 

 
• Land Manager  

 
• Crop Management  

• Crop Schedule 
 

• Flow Network 
• Reservoir 
• Reach  
• Junction 

 
• Atmospheric  

• Met Station 
 

• Water Management  
• System Manager 
• Area Manager 
• Delivery Manager 

 
• Alternatives  
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Global Data 
The Global Data Editors include: 
 

• Crop Types 
• Irrigation System Types 
• Soil Types 
• Crop Schedules 

 

Crop Type Editor 

 
 
Introduction 
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The Crop Type Editor was designed to enable the LAWS user to calculate 
evapotranspiration (ET) using the dual crop coefficient approach described in "Crop 
evapotranspiration - Guidelines for computing crop water requirements - FAO 
Irrigation and drainage paper 56" (Allen, et al., 1998), hereafter referred to as "FAO 
56."  Users of LAWS are urged to familiarize themselves with these calculations by 
reading the publication.   
 
 
Basic Editor Functionality 

 
Crop Type menu commands: 
 

Name Function Keyboard 
Shortcut 

New Create a new Crop Type 
 

Ctrl + N 

Save Save the changes made in the editor 
 

Ctrl + S 

Delete 
  

Delete the Crop Type currently displayed in the editor from the 
current Project 
 

 

Rename Rename the Crop Type current displayed in the editor  
 

 

Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 
 

 

 
Help menu commands: 
 
Name Function 
Help Displays the Crop Type Editor's help information in the LAWS online Help window 

 
 
Crop Type Selection: 
 

The Crop Type Editor allows you to browse through all the Crop Types created in 
the Project.  The name of the current Crop Type appears in the Name field.  To view 
other Crop Types, use the scroll buttons to the right of the Name field or select the 
Crop Type's name from the Name dropdown list. .  The following is a table of the 
buttons and their functionality: 

 
Button Function 

 
 View first record 
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 View previous record 

 
 Current record displayed out of total number of records 

 
 View last record 

 
 View next record in the list 

 
 
Description: 
 

The Description field displays the description for the current Crop Type.  The 
description can be edited by typing in the field.  A text window is available through 
the eclipse  button in the text-field.   
 

Button Panel: 
 

Button Function 

 
Save the changes made and close the editor  

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
 
Specific Editor Functionality 

 
 
Plant Life Cycle: 
 

The Plant Life Cycle combo box contains only one choice at this time:  
 

• Annual  
 
However, perennial vegetation may be simulated in LAWS as described below. 
 

Calculate fc:  
 

Checking this box will have LAWS calculate fc, the soil cover fraction, instead of 
requiring the user to enter it in the Growth Stage Table.  When this option is selected 
the "fc" column in the Growth Stage Table will be replaced with the Kc min column.  
When this option is checked the following equation is solved: 
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Kcb - basal crop coefficient 
Kcmin - minimum value of Kc for a bare dry soil 
Kcmax - maximum value for Kcb 
h - plant height 

 
Kcb and Kcmax are calculated by LAWS based on information entered in the Crop 
Type Editor 

 
Pre-Germination Periods: 

 
Enter the number of pre-germination periods.  Pre-germination periods are periods 
of the year prior to planting in which crop transpiration does not occur but irrigation 
may occur in order to meet some management objective such as soil salt leaching or 
pre-irrigation.  Entry of a non-zero number in this field will add a row(s) to the 
Growth Stage Table prior to the "Initial" stage. 
  

Post-Harvest Periods: 
 

Enter the number of post-harvest periods.  Post-harvest periods are periods of the 
year after harvest during which crop transpiration does not occur but irrigation may 
be needed to meet some management objective such as rice straw decomposition.  
Entry of a non-zero number in this field will add a row(s) to the Growth Stage Table 
after to the "Late" stage. 

 
Planting Dates: 

 
The Planting Date section contains entry fields for Early Planting and the Late 
Planting.  The date (DDMMM format) can be entered manually into the two fields 
or selected using the Calendar Tool accessed through the eclipse  button in each 
field.  The Early End of Harvest and Late End of Harvest field data are calculated 
by the editor using the Total Duration in the Growth Stage Table.  The Total 
Duration is added to the Early Planting date to get the Early End of Harvest date and 
added to the Late Planting date to acquire the Late End of Harvest.  The actual 
planting date will be entered in the Crop Schedules data screen. 

 
Growth Stage Table: 
 

Within this table, each stage of the plant's growing cycle requires additional 
information.  
 

• Initial - This stage runs from planting to approximately 10% ground 
cover.  For perennial crops this stage starts with "greenup." 
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• Development - This stage runs from 10% crop cover to effective full 
cover (when soil shading is complete). 

• Mid - This stage runs from effective full cover to the start of maturity. 
• Late - This stage runs from the start of maturity to harvest or full 

senescence. 
 

The sum of the total number of days in the growth period is calculated and displayed 
in the Total Duration row of the table.  Each growth period requires the following 
information: 

 
1.  Duration in days - The number of days in the growth period. 
2.  Kcb - The basal crop coefficient (dimensionless). 
 
The basal crop coefficient varies over the growing season with its values specified 
as shown in Figure 1 and Table 1 below.  Please note that to have the Kcb values 
properly interpolated, the user needs to enter the "initial" Kcb value in both 
the "Initial" and "Dev" rows of the table.  Representative values of Kcb for many 
crops can be found in Table 17 of FAO 56 (Allen, et al., 1998) 
 
 

Growth 
Stage 

Dur - 
ation 

Kcb Root 
Zone 
Depth 

Ponding 
Depth 

MAD RH h u2 fc1 Kc min1 

Initial  Kcbi RDi PDi MADi RHi hi u2i fci Kcmini 
Dev  Kcbi RDi PDd MAD

d 
RHd hi u2d fcd Kcmind 

Mid  Kcbm RDm PDm MAD
m 

RHm hm u2m fcm Kcminm 

Late  Kcbl RDm PDl MADl RHl hm u2l fcl Kcminl 
           

 
Table 1.  Growth Stage Table Variables. 
 
1. See discussion in subsection 9 below for information on how to enter these 
values. Note bold values in Table indicate variables that are remain the same in than 
one Growth Stage. 
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Figure 1.  Example of time varying Kcb values based on values specified in the 
Growth Stage Table. 
 
 
3.  Root Zone Depth (RD) - the depth of the plant root zone (ft or m). 
 
Consistent with FAO 56, root zone depth increases from the initial value to the 
maximum value during the development stage.  Therefore, values of root zone 
depth for the "Initial" and "Dev" rows of the table should be identical as 
should the "Mid" and "Late" (Figure 2 and Table 1).  Representative values for 
rooting depth can be found in Table 22 of FAO 56. 
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Figure 2.  Example of time varying root zone depth as specified in the Growth 
Stage Table. 
 

 
4.  Ponding Depth (PD) - depth of ponding is required for certain crops (e.g. for 
rice) (ft or m). For most crops ponding depth is 0. 
 
The ponding depth is specified for each growth stage (Figure 3,Table 1).  
 
 

 
 

 
Figure 3.  Example of time varying ponding depth as specified in the Growth 
Stage Table. 
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5.  Management Allowable Depletion (MAD) - management allowable depletion 
(dimensionless) is the fraction of the plant available water holding capacity that the 
crop can utilize before irrigation is requested.   Available water capacity is defined 
as the difference between the water content at field capacity and the water content at 
permanent wilting point.  For example, a MAD value of 0.4 means that plants can 
transpire 40% of the plant available water holding capacity before an irrigation is 
requested. Values of MAD are specified for each growth stage (Figure 4, Table 1).  
Representative values of the depletion fraction, or MAD, can be found in Table 22 
of FAO 56. 
 
 

 
 
 
Figure 4.  Example of time varying MAD as specified in the Growth Stage 
Table. 
 
 
6.  Relative humidity (%) (RH) -  The mean value for daily minimum relative 
humidity during the mid- or late season growth stage. Values are specified for each 
growth stage (Figure 5, Table 1).  This information is used by LAWS to compute the 
value of KCmax used in the dual crop coefficent method. See Technical Reference 
Section. 
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Figure 5.  Example of time varying minimum daily relative humidity as 
specified in the Growth Stage Table. 
 
7. Plant height (h) - maximum plant height during the growth stage period of 
calculation (ft or m).  Values are specified for each growth stage (Figure 6, Table 1). 
Note that the same values are used for the Ini-Dev stages and Mid-Late stages. 
This information is used by LAWS to compute the value of KCmax used in the dual 
crop coefficient method. See Technical Reference Section. 
 
 

 
 
Figure 6.  Example of time varying mean maximum plant height as specified in 
the Growth Stage Table. 
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8. Wind speed ( u2 ) - mean value of daily wind speed at 2 m height (ft/s or m/s). 
Values are specified for each growth stage (Figure 7, Table 1). This information is 
used by LAWS to compute the value of KCmax used in the dual crop coefficent 
method. See Technical Reference Section. 
 

 
 

 
Figure 7.  Example of time varying mean daily wind speed as specified in the 
Growth Stage Table. 
 
9. Soil cover fraction / Kc minimum ( fc / Kcmin ) - fc is the soil cover fraction 
(dimensionless), Kcmin is the minimum Kc for dry bare soil with no ground cover 
(dimensionless).  If fc is to be specified then the user enters a value for each growth 
stage.  If fc is to be calculated by LAWS then this column changes to Kcmin and a 
value should be entered for each growth stage (Figure 8, Table 1).  Representative 
values of fc can be found in Table 21 of FAO 56. 
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Figure 8.  Example of time varying fc (or Kcmin) as specified in the Growth 
Stage Table. 
 

Root Water Uptake Factors 
 
Plant transpiration can be limited using a function that is equal to 1.0 for a range of 
optimal pressure heads (PH) and less than 1.0 for anoxic (very wet) and very dry 
conditions (Feddes, 1974) (Figure 9).  Transpiration is limited for |PH|> PHmax and 
|PH|<PHmin.  It is assumed transpiration ceases at |PH| = 15,0000 cm. 
 
 

• Min Pressure Head for Full ET (PHmin) - pressure head value at which 
anoxic conditions start to limit plant transpiration (PHmin on Figure 9). 

• Max Pressure Head for Full ET (PHmax) - pressure head at which 
transpiration starts to be limited by a lack of soil moisture (PHmax on Figure 
9). 
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Figure 9.  Example of the transpiration limiting function. 
 
 
 
Additional Information: 
 

• Crop Types 
• Adding Crop Types 
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Irrigation System Type Editor 

 
 
Basic Editor Functionality 
 
Help menu commands: 
 
Name Function Keyboard 

Shortcut 
Help Displays the Irrigation System Editor's help information in the 

LAWS online Help window 
 

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
Specific Editor Functionality 
 
Irrigation Table: 
 
The Irrigation System Types Editor lists the available irrigation systems.  Each row in the 
table represents a different irrigation system type.  There are four default irrigation 
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system types initially provided: sprinkler, furrow, flood, and drip. However, additional 
irrigation system types can be added.   Below is a description of the requirements: 
 

• Type - Name of the irrigation system type. 
• Distribution Uniformity - Determines the amount of additional irrigation water 

delivered to account for the non-uniformity of the irrigation application.  The 
distribution uniformity is typically expressed as the ratio of the average depth of 
water applied to the quarter of the field receiving the least water over the average 
depth of water applied to the entire field.   

• fw - The fraction of the irrigated area that is wetted by the irrigation and therefore 
the field may potentially have bare soil evaporation.  For instance, sprinklers 
usually have an fw = 1.0 while drip irrigation may have an fw of 0.4.  Table 20 in 
FAO 56 provides representative values of fw. 

• Application Rate - The water application rate of the irrigation system type (ft/d 
or m/d). 

 
To enter any information in the table, simply click the cell and type. 
 
Additional Information: 
 

• Adding Irrigation Types 
• Irrigation Types 
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Soil Types Editor 

 

 
 
Introduction 
 
The Soil Types Editor allows the user to enter various soil physical properties including 
percent sand, silt, and clay, bulk density, and saturated hydraulic so that unsaturated flow 
parameters can estimated using the Neuro Multi-Step pedo-transfer program created by 
Minasny, et al. (2004) (Soil Sci. Soc., Am. J. 68:417-429) to estimate the van Genuchten 
parameters.  Soil water content at saturation, field capacity, permanent wilting point and 
saturated hydraulic conductivity are then estimated using these van Genuchten 
parameters. These parameters are also used to simulate unsaturated flow conditions 
during infiltration events. 
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 At a minimum, the user is required to enter representative values for the 
percentages of sand, silt and clay associated with each soil type. Additional 
information such as the bulk density, saturated water content, and saturated hydraulic 
conductivity can be entered if available. 
 
If the saturated hydraulic conductivity is not specified by the user then LAWS calculates 
the hydraulic conductivity at saturation using the pedo-transfer function of Cosby, et al. 
(1984) found in Water Resources Research. 20:682-690.  
 
The user must also enter values for the thickness of the evaporation layer and the 
readily evaporable water (REW) for use in the bare soil evaporation calculations made 
using the approach outlined in FAO 56 (see the Crop Type Editor for more information).  
Representative values for the REW can be found in Table 19 of FAO 56. 
 
 
Basic Editor Functionality 
 
Soil Type menu commands: 
 

Name Function Keyboard 
Shortcut 

New Create a new Soil Type Ctrl + N 
Save Save the changes made in the editor Ctrl + S 

Rename Rename the Soil Type current displayed in the editor   

Delete 
Delete the Soil Type currently displayed in the editor from the 
current Project 

 

Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 

 

 
Help menu commands: 
 
Name Function Keyboard 

Shortcut 
Help Displays the Soil Type Editor's help information in the LAWS 

online Help window 
 

 
 
Soil Type Selection: 
 
The Soil Type Editor allows you to browse through all the Soil Types created in the 
Project.  The name of the current Soil Type appears in the Name field.  To view other 
Soil Types, use the scroll buttons to the right of the name field or select the Soil Type's 
name from the Name dropdown list.  The following is a table of their functionality: 
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Button Function 
 

 
 

View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
Description: 

 
The Description field displays the description for the current Soil Type.  The description 
can be edited by typing in the field.  A text window is available through the eclipse  
button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
 
Specific Editor Functionality 
 
Soil Property Input Values: 
 

Below are descriptions for the editable entry fields for the soil properties: 
 

• Sand Content (%) - Percentage of sand found in the soil (required). 
• Silt Content (%) - Percentage of silt found in the soil (required). 
• Clay Content (%) - Percentage of clay found in the soil (required). 
• Bulk Density (g/cm) - Bulk density of soil (optional). 
• Theta_s (cm3/cm3) - Water content at saturation (optional). 
• Ksat (cm/h) - Hydraulic conductivity at saturation (optional). 
• Evap Layer (cm) - Thickness of the evaporation layer used in the dual crop 

coefficient approach for calculating crop evapotranspiration described in FAO 56. 
Typical values range from 10 to 15 cm (required).  
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• REW - Readily Evaporable Water.  This is the water that can be evaporated from 
the soil during Stage 1 of the drying process.  During Stage 1, the soil is wet 
enough that bare soil evaporation is only limited by the evaporative energy 
available at the soil surface.  Table 19 in FAO 56 provides typical values for 
REW (required). 

 
Estimated Van Genuchten Parameters: 
 

The following describes the estimated van Genuchten parameter properties of the 
soil: 
 

• Theta r - residual water content. 
• Theta s - water content at saturation. 
• Alfa (1/cm) - van Genuchten parameter. 
• n - van Genuchten parameter. 
• Ko (cm/h) - van Genuchten parameter. 

 
NOTE:  The sand, silt, and clay percentages combined total must equal 100% in 
order for the editor to close.   

 
Calculated Soil Properties: 
 

The following describes the calculated soil properties in the editor: 
 

• Soil Water Content at Saturation (ND) 
 

• Soil Water Content at Field Capacity (ND) 
• Field Capacity assumed to be at 333 cm (1/3 bar) of pressure head. 

• Soil Water Content at Permanent Wilting (ND) 
• Permanent Wilting assumed to be 15,000 cm (15 bars) of pressure 

head. 
 

• Hydraulic Conductivity at Saturation (L/T) 
 

The hydraulic conductivity at saturation is either specified by the user or if it is not 
specified, it is automatically calculated using the pedo-transfer function of Cosby, et 
al. (1984) found in Water Resour. Res. 20:682-690.  This function predicts hydraulic 
conductivity as a function of the percent sand and clay in the soil. 

 
 
Additional Information: 

 
• Soil Types 
• Adding Soil Types 
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Crop Schedule Editor 

 
 
Introduction 
 
The Crop Schedule Editor allows users to browse through all the Crop Schedules 
created in the Project.  The name of the current Crop Schedule appears in the Name field. 
 To view other Crop Schedules, use the scroll buttons to the right of the name field or 
select the Crop Schedule's name from the Name dropdown list.  The following is a table 
of their functionality: 
 
Basic Editor Functionality 
 
Crop Schedule menu commands: 
Name Function Keyboard 

Shortcut 
New Create a new Crop Schedule Ctrl + N 
Save Save the changes made in the editor Ctrl + S 

Delete 
Delete the Crop Schedule currently displayed in the editor from 
the current Project 

 

Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 
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Edit menu commands: 
Name Function Keyboard 

Shortcut 
Crop 
Type 

Displays the Crop Type Editor.  

 
 
Help menu commands: 
Name Function Keyboard 

Shortcut 
Help Displays the Crop Schedule Editor's help information in the LAWS 

online Help window 
 

 
Crop Schedule Selection: 
 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
Description: 

 
The Description field displays the description for the current Crop Schedule.  The 
description can be edited by typing in the field.  A text window is available through the 
eclipse  button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 
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Specific Editor Functionality 
 
Schedule Table: 
 

Each row in the Schedule table represents a new planting event.  Below is a 
description of each column:  
 
Year - Represents the year the crop will be planted.   
 
Crop - Select the crop to be planted from the dropdown list filled with previously 
created Crop Types in the Crop column*. 
   
*If you need to edit or add a Crop Type access to the Crop Type Editor is available 
through the menu bar.  Select Edit then the Crop Type menu option.  
 
Plant Date - This field defaults to the selected Crop Types Early Planting date. 
 However, this date can be changed, as long as the date entered falls within the range 
of the Early and Late Planting dates predefined by the Crop Type.  If you would like 
to use a date outside the Crop Type range either edit the Crop Type dates or create a 
new Crop Type that best describes the dates needed.  For example: You may have 
two types of corn, Late and Early Corn.  They are both corn, but their planting dates 
differ.  
 
Harvest Date - The Harvest Date will be calculated by the editor using the Total 
Duration time of the selected Crop Type's growth stage from the time of the Plant 
Date.   

 
NOTE: During the Alternative's compute, if the year indicated by the Crop Schedule is 
not included in the time range of an Alternative computation, then the Crop Schedule will 
automatically determine the appropriate start crop and proceed to rotate the crops 
throughout the simulation.  However, the user needs to check whether the Crop Schedule 
is appropriate for their purposes. 
 
 
Additional Information: 
 

• Crop Schedules 
• Adding Crop Schedules 
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Land Manager 

 
 
Introduction 
 
The Land Manager is the fundamental calculation unit within LAWS.  It is at this scale 
that the interactions between soils, vegetation, and the atmosphere are calculated.  
Outputs from these calculations include surface runoff, infiltration, bare soil evaporation, 
plant transpiration, deep percolation, upflux from a shallow water table, soil moisture 
storage, and drain flows.  It is also within the Land Manager that irrigation demands are 
calculated as a function of the user specified management parameters (MAD and 
irrigation system characteristics). 
 
In addition to the water balance calculations described above, the Land Manager can be 
used to calculate demands based on a user specified constant demand or time series of 
demands.  This functionality is useful for representing demands outside of the LAWS 
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project area that nonetheless have an impact of reservoir storage or stream flow within 
the geographic area of the project. 
 
Basic Editor Functionality 
 
Land Manager menu commands: 
Name Function Keyboard 

Shortcut 

 Save 
Save the changes made in the editor Ctrl + S 

Rename Rename the Land Manager current displayed in the editor   

Delete 
Delete the Land Manager currently displayed in the editor from 
the current Project 

 

Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 

 

 
Edit menu commands: 

Name Function Keyboard 
Shortcut 

Soil Type Displays the Soil Type Editor  
Irrigation 
Type 

Displays the Irrigation Type Editor  

 
Help menu commands: 
Name Function Keyboard 

Shortcut 
Help Displays the Land Manager Editor's help information in the LAWS 

online Help window 
 

 
 
Land Manager Selection: 
 
The Land Manager Editor allows you to browse through all the Land Managers created in 
the Project.  The name of the current Land manager appears in the Name field.  To view 
other Land Managers, use the scroll buttons to the right of the name field or select the 
Land Manager's name from the Name dropdown list.  The following is a table of their 
functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
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 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
Description: 

 
The Description field displays the description for the current Land Manager.  The 
description can be edited by typing in the field.  A text window is available through the 
eclipse  button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
 
Specific Editor Functionality 
 
Land Use -This variable determines the method used to calculate water demand.  The 
choices are Irrigated Field and Other Demand.  If the Irrigated Field option is chosen 
then a full root zone water balance is calculated for each day of the simulation and 
irrigation water is ordered if the water content in the root zone reaches the Management 
Allowable Depletion and a crop is active.  If the Other Demand option in chosen then no 
root zone water balance is calculated and the user simply enters a constant water use rate 
or a time series of water use rates. 
 
The remainder of this section is describes data entries required for the Irrigated Field 
option. 
 
Calculate Area - If this option is chosen the area of the Land Manager is calculated by 
LAWS using the geometry of the polygon that represents it. 
 
Enter Area - If this option is chosen the user can enter a value for the Land Manager 
area.  This option should be used if a more abstract representation of a water resources 
system is required.  This allows the user to develop a model in which a Land Manager 
may represent a very large area with similar crop and soil properties yet the Land 
Manager polygon on the LAWS schematic does not exactly coincide with the boundaries 
of the modeled area. 
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Irrigation System Type - The Irrigation System Type drop down list is populated with 
previously created Irrigation System Types.  The selected Irrigation Type will represent 
the irrigation system used primarily in the Land Manager.  If an Irrigation System Type 
needs to be edited or created, the Irrigation System Types Editor can be accessed via the 
Edit  -> Irrigation Type menu option within this editor. 
 
Drain Inflow Factor (0-1) - The Drain Inflow Factor field allows entry of a value 
ranging from 0 to 1.  This value represents the fraction of the deep percolation that will 
go into the drainage system of the Delivery Manager and is made available to other 
Delivery Managers as a function of the settings in the Delivery Manager Editor. 
 
Water Table Depth - This value is used to calculate the amount of groundwater upflux 
that can be used to meet plant water demand.  If the groundwater modeling option is 
being used this value is calculated by LAWS.  If the water table is deep enough that no 
plant transpiration demand is met by the water table source then this number should be 
large (>20 ft or 6 m) 
 
Enter Soil By - The soil information for the Land Manger may be entered in two ways, 
by Soil Types or Soil Properties.  Both are available through the Enter Soil By dropdown 
list.   The following is a description for each selection: 
 

• Soil Types (default) 
 

 
 
Enter Soil by Soil Types uses a table for data entry (see above figure).  Previously 
defined soil types described by the user in the Soil Type Editor are chosen.  With this 
approach the user selects the soil types present in the Land Manager and assigns a 
percentage of each type to represent the portion of the Land Manager covered by a 
particular soil type.  LAWS then uses these percentages to calculate a weighted average 
value for percent sand, silt, and clay.  If present, a weighted average of bulk density, 
Theta_S and Ksat are also calculated.  These average values are then used as input for the 
Neuro Multi-Step pedo-transfer program created by Minasny, et al. (2004) (Soil Sci. 
Soc., Am. J. 68:417-429) which estimates the van Genuchten parameters.  Soil water 
content and saturation, field capacity, and permanent wilting point are then calculated 
using the van Genuchten parameters.  
 
If the hydraulic conductivity at saturation is not provided by the user then LAWS 
calculates the hydraulic conductivity at saturation using the pedo-transfer function of 
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Cosby, et al. (1984) found in Water Resources Research. 20:682-690.  This pedo-transfer 
function uses as inputs the percent sand and clay. 
 
Weighted averages for the thickness of the evaporation layer and the readily evaporable 
water (REW) are also calculated using the soil type percentages 
 
Note: If a Soil Type needs to be edited or created, the Soil Type Editor is available via 
the Edit->Soil Type menu option on the editor. 
 
Enter Soil By - This is an alternative way to specify Land Manager soil properties. 
 

• Soil Properties 
  
If this option is selected then the user has the choice of entering either the Soil Property 
Input Values and having the Neuro Multistep pedo-transfer program calculate the van 
Genuchten parameters or directly entering the van Genuchten parameters.  The following 
Land Manager soil property values can be entered. 

 
Soil Property Input Values: 
 

• Sand Content (%) - Representative percentage of sand found in the Land 
Manager (required). 

• Silt Content (%) - Representative percentage of sand found in the Land Manager 
(required). 

• Clay Content (%) - Representative percentage of sand found in the Land 
Manager (required). 

• Bulk Density (g/cm) - Representative percentage of sand found in the Land 
Manager. 

• Theta_s (cm3/cm3) - Representative percentage of sand found in the Land 
Manager. 

• Ksat (cm/h) - Representative percentage of sand found in the Land Manager. 
• Evap Layer (cm) - Representative thickness of the evaporation layer found in 

Land Manager used in the dual crop coefficient approach for calculating crop 
evapotranspiration described in FAO 56. Typical values range from 10 to 15 cm 
(required).  

• REW - Representative amount of Readily Evaporable Water found in Land 
Manager that can be evaporated from the soil during Stage 1 of the drying 
process.  During Stage 1, the soil is wet enough that bare soil evaporation is only 
limited by the evaporative energy available at the soil surface.  Table 19 in FAO 
56 provides typical values for REW (required). 

•  
   

Calculated Soil Properties: 
 

The following describes the calculated Soil Properties in the editor: 
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• Soil Water Content at Saturation (ND) 
 

• Soil Water Content at Field Capacity (ND) 
• Field Capacity assumed to be at 333 cm (1/3 bar) of matric 

potential. 
• Soil Water Content at Permanent Wilting (ND) 

• Permanent Wilting assumed to be 15,000 cm (15 bars) of matric 
potential. 
 

• Hydraulic Conductivity at Saturation (L/t) 
 
 
Additional information: 
 

• Creating a Land Manager 
• Land Manager 
• Land Manager Summary 
• Technical information of the Land Manager 
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Crop Management 

 
 
Introduction 
 
The Crop Management Module editor is used to specify crop schedules that are used by 
Land Mangers during the LAWS simulation. 
 
Basic Editor Functionality 
 
Crop Management Module menu commands: 
Name Function Keyboard 

Shortcut 
 Save Save the changes made in the editor Ctrl + S 

Rename Rename the Crop Management Module current displayed in the 
editor  

 

 Delete 
Delete the Crop Management Module currently displayed in the 
editor from the current Project 
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Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 

 

 
Help menu commands: 
 
Name Function Keyboard 

Shortcut 
Help Displays the Crop Management Module Editor's help information 

in the LAWS online Help window 
 

 
Crop Management Module Selection: 
 
The Crop Management Module Editor allows a user to browse through all the Crop 
Management Modules created in the Project.  The name of the current Crop Management 
Module appears in the Name field.  To view other Crop Management Modules, use the 
scroll buttons to the right of the name field or select the Crop Management Module's 
name from the Name dropdown list.  The following is a table of their functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
Description: 

 
The Description field displays the description for the current Crop Management Module. 
 The description can be edited by typing in the field.  A text window is available through 
the eclipse  button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 
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Do not save the changes made and close the editor 

 
 
Specific Editor Functionality 
 

• Land Module: 
 

The Land Module dropdown list includes all Land Modules created in the Project. 
 Select a Land Module to use in the Crop Management Module. 

 
• Land Module Table: 

 
Once a Land Module is selected the collection of Land Managers that populate the 
Module will be listed in a table.  Each row in the table represents a crop event.  For 
each Land Manager a Crop Schedule is assigned.  The Crop Schedules are listed in 
the Crop Schedule column's dropdown menu.  All previously created Crop 
Schedules are available for selection. 

 
Additional Information: 
 

• Land Modules 
• Creating Land Modules 
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Flow Network Module 
The Flow Network Editors include: 
 

• Reservoir 
• Reach 
• Junction 

 Reservoir Editor 

 
 
Introduction 
 
The Reservoir Editor allows the user to provide information about the physical 
characteristics and water management operations associated with it. 
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Basic Editor Functionality 
 
Reservoir menu commands: 
 

Name Function Keyboard 
Shortcut 

 New Create a new Reservoir Ctrl + N 
 Save Save the changes made in the editor Ctrl + S 

Rename Rename the Reservoir currently displayed in the editor   

Delete 
Delete the Reservoir currently displayed in the editor from the 
current Project 

 

Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 

 

 
Help menu commands: 
 
Name Function Keyboard 

Shortcut 
Help Displays the Reservoir Editor's help information in the LAWS 

online Help window 
 

 
Reservoir Selection: 
 
The Reservoir Editor allows you to browse through all the Reservoirs created in the 
Project.  The name of the current Reservoir appears in the Name field.  To view other 
Reservoirs, use the scroll buttons to the right of the name field or select the Reservoir's 
name from the Name dropdown list.  The following table describes their functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
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Description: 
 

The Description field displays the description for the current Reservoir.  The description 
can be edited by typing in the field.  A text window is available through the eclipse 
 button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
 
Specific Editor Functionality 
 
Maximum Conservation Storage: 
 
The Maximum Conservation Storage is the volume of the reservoir's total maximum 
storage that can be delivered to downstream users. 
 
 
Instream Flow Requirement: 
 
The Instream Flow Requirement specifies the reservoir release rate needed to meet 
downstream flow requirements.  For example, this could be a release required for 
maintaining favorable in-stream aquatic habitat conditions.  It can be specified as a 
constant value or as a time series of daily releases if varying flow requirements are 
needed.  If the time series option is selected, a time series data file must be selected in the 
Alternatives Editor, Input Time Series tab. 
 
 
Release Capacity Option: 
 
The Release Capacity Option represents the physically constrained maximum release 
for the reservoir.  There are currently two options.   
 

• Constant 
Using a Constant release rate requires only that the Maximum Release Capacity be 
entered once.  This value is the maximum rate the reservoir can release water at any 
time. 

 
• Time Series 
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The Time Series option allows for a DSS record to be used to set the maximum 
release capacity for the reservoir.  The DSS record specifies the day, month, and 
year of the release.  A variable name for the Time Series must be given in the Time 
Series Name text field.  This variable will need to have a DSS file and record 
assigned to it in the Alternatives Editor's Time Series tab.  There, the variable name 
will be displayed along with the Reservoir's name.  

 
See the Area Manager Accounts tab 
 
Additional Information: 
 

• Reservoirs 
• Creating a Reservoir 
• Editing a Reservoir 
• Drawing Reservoirs 
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Reach Editor 

 
 
Introduction 
 
The Reach editor allows the user to specific physical characteristics are associated with 
flows traveling through the reach. 
 
Basic Editor Functionality 
 
Reach menu commands: 
 
Name Function Keyboard 

Shortcut 
 New Create a new Reach Ctrl + N 

 Save 
Save the changes made in the editor Ctrl + S 

Rename Rename the Reach currently displayed in the editor   

Delete 
Delete the Reach currently displayed in the editor from the current 
Project 

 

Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 

 

 
Help menu commands: 
Name Function Keyboard 

Shortcut 
Help Displays the Reach Editor's help information in the LAWS online 

Help window 
 

 
Reach Selection: 
 
The Reach Editor allows you to browse through all the Reaches created in the Project. 
The name of the current Reach appears in the Name field.  To view other Reaches, use 
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the scroll buttons to the right of the name field or select the Reach's name from the Name 
dropdown list.  The following is a table of their functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
Description: 

 
The Description field displays the description for the current Reach.  The description can 
be edited by typing in the field.  A text window is available through the eclipse  button 
in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
 
Specific Editor Functionality 
 
By default, Reaches have no effect on the water that passes through them. However, if 
you have specifications for the Reach, the Reach's information can be changed through 
this editor.   
 
• Travel Time - Travel Time represents the number of days it takes for water to travel 

the length of the reach.  The numerical value can be represented as a fraction.  For 
example, if it takes only a half a day (12 hours) for water to pass through the reach, 
0.5 can be entered as the Travel Time. 
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• Channel Losses as a Function of Flow - Channel Losses can be specified as a 
function of flow.  The value represents the ratio of the water lost to the amount of 
water that entered the reach.  This value will never exceed 1.  For instance: If 1000 
cfs enters the reach and 150 cfs of that 1000 cfs is lost, the value to enter would be 
.15 (150/1000 = .15).  If a negative value is entered then the channel will gain water.  
Use this to represent cases in which the channel is gaining water from the 
groundwater system.  If the groundwater functionality is being used then losses or 
gains from/to the reach are calculated by the groundwater model and the user value 
is ignored. 

 
 
Additional Information: 
 

• Reaches 
• Creating a Reach 
• Moving Reaches 
• Editing Reach Data 
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Junction Editor 

 
 
Introduction 
 
The Junction Editor allows the user to specify how flow is divided when reaches 
converge or diverge. 
 
 
Basic Editor Functionality 
 
Junction menu commands: 
 

Name Function Keyboard 
Shortcut 

 Save Save the changes made in the editor Ctrl + S 
Rename Rename the Junction currently displayed in the editor   

Delete 
Delete the Junction currently displayed in the editor from the 
current Project 

 

Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 
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Help menu commands: 
 
Name Function Keyboard 

Shortcut 
Help Displays the Junction Editor's help information in the LAWS 

online Help window 
 

 
Junction Selection: 
 
The Junction Editor allows users to browse through all the Junctions created in the 
Project.  The name of the current Junction appears in the Name field.  To view other 
Junction, use the scroll buttons to the right of the name field or select the Junction's name 
from the Name dropdown list.  The following is a table of their functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
Description: 

 
The Description field displays the description for the current Junction.  The description 
can be edited by typing in the field.  A text window is available through the eclipse 
 button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 
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Specific Editor Functionality 
 
Junctions are automatically created when Reservoir and Reaches are produced. 
 However, the weights can be changed through this editor.   
 
Downstream Flow Spill: 
 
The Downstream Flow Spill table lists all Downstream Reaches connected to the 
current Junction.  If there is more than one downstream reach a Flow Weight value is 
required.  The Flow Weight represents how the Junction distributes its outgoing flow to 
multiple reaches.  For example:  A Junction may split the outflow 40/60 between two 
downstream reaches.  The first reach's Flow Weight would then be 0 .4 and the second 
reach, 0.6.  If only one reach is downstream, the Flow Weight will be 1.0 regardless of 
what is entered in the editor. 
 

 
 
The Local Flow tab allows for the specification of inflows to a junction.  This feature 
should be used for junction nodes that are upstream of a reservoir.  Currently, LAWS 
does not manage water that is freely flowing in a stream.  In order for water to be 
managed (used for irrigation) it must first flow into a reservoir.  The System Manager 
field specifies to which System Manager account in the receiving reservoir the water will 
accrue.   
 
Additional Information: 
 

• Junctions 
• Moving a Junction 
• Editing a Junction 
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Atmospheric 

Met Station Editor 
 

 
 
Introduction 
 
A Met Station provides daily a time series of precipitation (Prcp) and reference crop 
evapotranspiration (ETo) values to be used in computing the water budget of Land 
Managers within its area of influence.  The station location is represented by an icon on 
the LAWS project map and in the LAWS Project tree.  The influence that each Met 
Station has on a particular Land Manager is a function of the Met Station's area of 
influence and the distance between the Met Station and the Land Manager.  If a Land 
Manager falls within the Met Station area of influence then the ETo and Prcp values for 
the Land Manager will be obtained from the Met Station.  If the Land Manager falls 
within more than one Met Station's area of influence then the ETo and Prcp values will 
be interpolated based on the relative distance between the Land Manager and each of Met 
Stations. 
 
Basic Editor Functionality 
 
Help menu commands: 
 
Name Function Keyboard 

Shortcut 
Help Displays the Met Station Editor's help information in the LAWS 

online Help window 
 

 
Met Station Selection: 
 
The Met Station Editor allows a user to browse through all the Met Stations created in the 
Project.  The name of the current Met Station appears in the Name field.  To view other 
Met Stations, use the scroll buttons to the right of the name field or select the Met 
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Station's name from the Name dropdown list.  The following table describes their 
functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
Description: 

 
The Description field displays the description for the current Met Station.  The 
description can be edited by typing in the field.  A text window is available through the 
eclipse  button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
 
Specific Editor Functionality 
 
Region Type: 
 
The Region Type represents the type of shape drawn for the Met Station's area of 
influence.  The user must make certain that at least one Met Station's area of 
influence surrounds each Land Manager.  If multiple Met Station's area of influence 
surround a Land Manager, the ETo and Prcp values will be interpolated between them by 
inverse distance square weighting. The shapes are not visible in the Map Schematic by 
default.  (See Viewing Met Station Shapes) .  The two shape types available in the 
dropdown list are discussed below: 
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• Polygon 

 
 
The Polygon shape can be configured into any shape through the Map Schematic. 
 The initial shape is a square.  Points can be moved and added to increase the area 
and change the shape.  If Polygon is selected as the Region Type, the Radius field 
will not be available for editing.   

 
• Radius 

 
 
The Radius shape is a circle centered on the Met Station.  The radius of this circle is 
determined by the value in the Radius field.  The circle is calculated and draws 
using the value.  There is no user interaction with the circle in the Map Schematic.  
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Water Management 
The Water Management Module contains the following editors: 
 

• System Manager Editor 
• Area Manager Editor 
• Delivery Manager Editor 

 

System Manager Editor 

 
 
Introduction 
 
The System Manager Editor allows the user to specify what reservoirs are managed by 
each System Manager and how the System manager interacts with each of the Area 
Managers having Water Accounts with it. 
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Basic Editor Functionality 
 
System Manager menu commands: 
 

Name Function Keyboard 
Shortcut 

 New Create a new System Manager Ctrl + N 
 Save Save the changes made in the editor Ctrl + S 

Rename Rename the System Manager current displayed in the editor   
Delete Delete the System Manager currently displayed in the editor 

from the current Project 
 

Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 

 

 
Help menu commands: 
 
Name Function Keyboard 

Shortcut 
Help Displays the System Manager Editor's help information in the 

LAWS online Help window 
 

 
System Manager Selection: 
 
The System Manager Editor allows a user to browse through all the System Managers 
created in the Project.  The name of the current System Manager appears in the Name 
field.  To view other System Managers, use the scroll buttons to the right of the name 
field or select the System Manager's name from the Name dropdown list.  The following 
table describes their functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
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Description: 
 

The Description field displays the description for the current System Manager.  The 
description can be edited by typing in the field.  A text window is available through the 
eclipse  button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
 
Specific Editor Functionality 
 
Reservoir Accounts Tab: 
 
• Flow Network - The Flow Network contains a dropdown list of previously created 

Flow Networks in the current Project.  The reservoirs in the selected Flow Network 
will be used to create Reservoir Accounts. 

 
• Reservoir Account Table - The Reservoir Account Table displays existing 

Reservoir Accounts.  The Reservoir Accounts name can be changed within the table 
by double clicking in the Reservoir Account Name cell.   Each Reservoir Account 
will need a % Conservation Storage entered.  This storage represents the percentage 
of the conservation pool that can be used for the Reservoir Account.   To change or 
add a storage value, double-click in the % Conservation Storage cell of the 
Reservoir Account then type in the value.   
 

• Add Account - Use the Add Account button to add a Reservoir Account to the 
Reservoir Account table.  Clicking the button displays the New Reservoir Account 
dialog pictured below.  Assign the new Reservoir Account to a Reservoir using the 
Reservoir dropdown list of previously created Reservoirs.  
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• Remove Account - The Remove Account button will remove the selected Reservoir 
Account in the Reservoir Account Table.  A conformation message will display to 
verify the removal of the Reservoir Account. 
 

• Reservoir Usage - Reservoir Usage describes the allocation or distribution of the 
Reservoir Accounts.  There two types of Allocation represented: 
 

• Balance Allocation removes total volume of water to be delivered in 
equal amounts from each Reservoir Account. 
 

• Sequential Allocation removes the total volume of water to be delivered 
from each Reservoir Account sequentially, starting with the first Reservoir 
Account in the Table.  Once that Reservoir Account's maximum release is 
reached, the next Reservoir Account in the table will be used and so forth. 

 
Use the radio buttons to select which Allocation one you would like to use. 
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Water Accounts Tab: 
 

 
 
NOTE: An Area Manager should be created before using this tab.  Water Accounts 
are shared by System and Area Managers.  Area Managers are needed before 
creating the Water Accounts.   
 
• Water Account Table - The Water Account Table displays existing Water 

Accounts.  The Water Accounts name can be changed within the table by double 
clicking in the Water Account Name cell.   Each Water Account will need a Fill 
Priority and Maximum Yearly Volume.  The volume is the maximum amount of 
water that can be used for the Water Account.  To change or add a volume or 
priority, double-click in the cell under the corresponding column to set the cell 
editable.  Each Account has a maximum annual volume of water associated with it. 
The Fill Priority can be used to determine the order that Accounts are receive water 
as reservoir inflows occur. The total volume for the collection of Water Accounts is 
displayed at the bottom of the table.    
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• Remove Account - The Remove Account button will remove the selected Water 
Account in the Water Account Table.  A conformation message will display to 
verify the removal of the Water Account. 
 

• Delivery Priority - sets the manner in which multiple water accounts are managed 
by LAWS.  There are two types of Delivery Priorities.  
 

• Balance Allocation removes total volume of water to be delivered in 
equal amounts from each Reservoir Account. 
 

• Sequential Allocation removes the total volume of water to be delivered 
from each Reservoir Account sequentially, starting with the first Reservoir 
Account in the Table.  Once that Reservoir Account's maximum release is 
reached, the next Reservoir Account in the table will be used and so forth. 

 
Use the radio buttons to select which Allocation one you would like to use. 
 
 

Additional Information: 
 

• Technical Design on System Managers 
• System Manager 
• Creating a System Manager 
• Editing a System Manager 
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Area Manager Editor 

 
  
Introduction 
 
The Area Manager Editor allows the user to specify the characteristics of its Water 
Accounts and how they are managed as well as its relationship with its Deliver Managers. 
 
   
Basic Editor Functionality 
 
System Manager menu commands: 
 

Name Function Keyboard 
Shortcut 

 New Create a new Area Manager Ctrl + N 
 Save Save the changes made in the editor Ctrl + S 

Rename Rename the Area Manager current displayed in the editor   
Delete Delete the Area Manager currently displayed in the editor from 

the current Project 
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Close Close the editor dialog.  If changes were made, a Save Changes 
dialog will display. 

 

 
Help menu commands: 
 
Name Function Keyboard 

Shortcut 
Help Displays the Area Manager Editor's help information in the LAWS 

online Help window 
 

 
  
Area Manager Selection: 
  
The Area Manager Editor allows a user to browse through all the Area Managers created 
in the Project.  The name of the current Area Manager appears in the Name field. To 
view other Area Managers, use the scroll buttons to the right of the name field or select 
the Area Manager's name from the Name dropdown list.  The following table describes 
their functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
 
Description: 

 
The Description field displays the description for the current System Manager.  The 
description can be edited by typing in the field.  A text window is available through the 
eclipse  button in the text-field. 
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Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
 
  
Specific Editor Functionality 
  
Water Accounts Tab: 
  
Note: A System Manager should be created before using this tab.  Water Accounts are 
shared by System and Area Managers.  System Managers are needed when creating the 
Water Accounts.   
  

• Water Account Table - The Water Account Table displays existing Water 
Accounts.  The Water Accounts name can be changed within the table by double 
clicking in the Water Account Name cell.   Each Water Account requires a 
Maximum Yearly Volume.  This volume is the maximum amount of water that 
can be used from the Water Account.  To change or add a volume, double-click in 
the Maximum Yearly Volume cell to set it editable.  The Total Maximum 
Yearly Volume for the collection of Water Accounts is displayed at the bottom of 
the table.    

  
• Add Account - To add a Water Account use the Add Account button.  Clicking 

the button displays the New Water Account dialog displayed below.  Assign the 
new Water Account a previously created System Manager using the System 
Managers dropdown list.  
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•  Remove Account - The Remove Account button will remove the selected Water 
Account in the Water Account Table.  A conformation message will display to 
verify the removal of the Water Account. 

  
•  Account Usage - Account Usage describes the allocation or distribution of the 

Water Accounts.  There two types of Allocation represented: 
  

• Balance Allocation removes total volume of water to be delivered in equal 
amounts from each Reservoir Account. 

 
• Sequential Allocation removes the total volume of water to be delivered from 

each Reservoir Account sequentially, starting with the first Reservoir Account in 
the Table.  Once that Reservoir Account's maximum release is reached, the next 
Reservoir Account in the table will be used and so forth. 

  
Use the radio buttons to select the Allocation method you would like to use. 

  
 Delivery Managers Tab: 
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The Delivery Managers tab displays a list of existing Delivery Managers within 
the Area Manager.  Each Delivery Manager listed displays the total area for the 
Land Managers to which it delivers water.  The total area for all the Delivery 
Managers and their associated Land Managers is displayed at the bottom of the 
Table. 
  

Additional Information: 
 

•  Technical Design of Area Managers 
• Area Manager 
• Creating an Area Manager 
• Editing an Area Manager 
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Delivery Manager Editor 

 
 
Introduction 
 
The Delivery Manager Editor allows users to specify which Land Managers receiving 
water delivery, the physical characteristics the infrastructure; the sources of water used to 
meet demands and what non-agricultural uses may be served within the delivery area. 
 
Basic Editor Functionality 
 
Delivery Manager menu commands: 
 

Name Function Keyboard 
Shortcut 

 New Create a new Delivery Manager Ctrl + N 
 Save Save the changes made in the editor Ctrl + S 

Rename Rename the Delivery Manager current displayed in the editor   
Delete Delete the Delivery Manager currently displayed in the editor 

from the current Project 
 

Close Close the editor dialog.  If changes were made, a Save 
Changes dialog will display. 

 

 
Help menu commands: 
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Name Function Keyboard 
Shortcut 

Help Displays the Delivery Manager Editor's help information in the 
LAWS online Help window 

 

 
Delivery Manager Selection: 
 
The Delivery Manager Editor allows a user to browse through all the Delivery Managers 
created in the Project.  The name of the current Delivery Manager appears in the Name 
field.  To view other Delivery Managers, use the scroll buttons to the right of the Name 
field or select the Delivery Manager's name from the Name dropdown list.  The 
following table describes their functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
Description: 

 
The Description field displays the description for the current Delivery Manager.  The 
description can be edited by typing in the field.  A text window is available through the 
eclipse  button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 
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Specific Editor Functionality 
 
Connectivity Tab: 
 
• Diversion Location - The Diversion Location is the location where the water 

enters the Delivery Manager.  The Diversion Location is populated with a list of 
Junctions in the Flow Network.  
 

• Return Location - The Return Location is the location where the water leaves the 
Delivery Manager.  The Return Location is populated with a list of Junctions in the 
Flow Network.  

 
• Drainage Available to Other Delivery Managers Table - This Table allows the 

assignment of drainage produced by the current Delivery Manager to flow to other 
Delivery Managers.  The Percent field represents the portion of the total drainage 
produced by all the Land Managers within the current Delivery Manager that can be 
used by the target Delivery Manager. The sum of the values in the Percent field 
should be 100%.  The drainage produced by the current Delivery Manager is 
available to the target Delivery Managers on the following day. 

 
Physical Parameters Tab: 
 

 
 
• Delivery Canal - The Delivery Canal represents the water delivery system within 

the Delivery Manager.  This network is not explicitly modeled in LAWS.  However, 
losses to evaporation and groundwater can be specified. 
 
• Losses to Atmosphere - Percentage of water delivered that is lost to the 

atmosphere while traversing the canals located within the current Delivery 
Manager. 

• Losses to Groundwater - Percentage of the water delivered that is lost to or 
gained from the groundwater system while be conveyed in within the current 
Delivery Manager. 
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• Drain - The Drain represents the drainage system losses or gains (if present) in the 
Delivery Manager.  This network is not explicitly modeled in LAWS.  However, 
losses to evaporation and groundwater can be specified. 
 
• Losses to Atmosphere - Percentage of drainage water lost to the atmosphere 

while traversing the drainage system located within the current Delivery 
Manager. 

• Losses to Groundwater - Percentage of water lost/gained to/from the 
groundwater system while traversing the drainage system within the current 
Delivery Manager. 

 
 
Management Parameters Tab: 
 
• Drain Water Re-use (%) - This value represents the percentage of the total drain 

water in the current time step that can be used to meet irrigation demands within the 
current Delivery Manager.  Drain water may also be available to the current Delivery 
Manager if other Delivery Managers have set the current Delivery Manager as a 
recipient target on their Connectivity tab. 
 

• Groundwater Water Supply - The settings in this portion of the Management 
Parameters tab determine how much, if any, of irrigation demand will be met by 
groundwater.  The user can choose between either limiting groundwater pumping to a 
fixed percentage of overall irrigation demand or to a fixed volume. If Percent of 
Demand is specified in the Groundwater Supply dropdown list then the following 
screen will appear. 
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The specification of a Groundwater Min Use will result in LAWS supplying a 
percentage of the irrigation demand from groundwater.  The Groundwater Max Use 
will result LAWS supplying groundwater up to the specified maximum percentage of 
groundwater to meet irrigation demands.  In these situations, the assumed preference 
is to use surface water.  If there is a shortage of surface water, then groundwater will 
be used up to the specified maximum percentage of irrigation demand. 
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• Groundwater Min Use (%) - This value represents the minimum percentage of the 
Land Manager's irrigation demand that will be met using groundwater.  For 
example, if this value is 15%, then 15% of all irrigation demands in the current 
Delivery Manager will be met by groundwater.  To force a Delivery Manager to 
provide only groundwater to its Land Managers enter a value of 100%. 
 

• Groundwater Max Use (%) - This value represents the maximum percentage of the 
Land Manager's irrigation demand that can be met using groundwater.  For example, 
if this value is set to 80%, up to 80% of the irrigation demand can be met using 
groundwater.   
 

NOTE: The percentages of Groundwater Supply can be specified as either constant 
values or time series inputs. If the time series option is selected, then a time series 
path must be entered in the Alternative Editor.  
 
If the user wishes to limit the overall total volume of groundwater pumping (perhaps 
due to infrastructure constraints) then the Fixed Volume option can be chosen in the 
Groundwater Supply dropdown menu.  When this option is selected the following 
screen will appear. 
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If the Constant Capacity option is selected then the groundwater supply rate is 
limited by the capacity.  The user can select to use a constant capacity or a time series 
capacity.  If the Time Series option is selected then a time series path must be entered 
in the Alternative Editor. 
 

• Maximum Annual Pumping Volume - the maximum volume that can be 
pumped during a year. 
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Water Quality 
 
The concentration of a modeled non-reactive, conservative constituent may be specified 
as either a Constant or a Time Series.  If the Time Series option is selected then a Time 
Series path must be specified in the Alternative Editor. 
 
 
Other Supply 
 
The Other Supply option on the Management Parameters tab provides an option to 
model the use of a water supply that is neither groundwater nor surface water from the 
explicitly modeled surface water supply system.  This type of supply could include out of 
service area transferred water that was purchased and "wheeled" through the system.  The 
data input requirements are similar to the Fixed Volume groundwater case.  The 
transmission capacity can be specified as either a fixed rate or a time series.  A maximum 
annual volume can be also be specified and its water quality can be assigned to the 
supply. 

 
 
Urban Tab: 
 
Urban water users can be modeled using the Urban Tab in the Delivery Manager Editor.   
 
• Use - This is a text descriptor of the urban water use type. 

 
• Annual per Unit Use - This is the total amount of water used by each demand unit.  

A demand unit may be a person (per capita use), a store, a factory, etc. 
 

• Number of Units - This is the total number of units.  This could be the number of 
people in the urban area, the number of stores, number of factories, etc. 
 

• Consumptive Percent - This is the percentage of the delivered water that is 
consumptively used and cannot re-enter the water distribution system. 
 

• Surface Runoff Percent - This is the percentage of the non-consumptively used 
water that ends up as surface runoff.  The sum of surface runoff and the Deep 
Percolation Percent must be 100%. 
 

• Deep Percolation Percent - This is the percentage of the non-consumptively used 
water that ends up as deep percolation.  The sum of this and the surface Runoff 
Percent must be 100%. 

 
 

Additional Information: 
 

• Technical Design of Delivery Managers 
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• Delivery Managers 
• Creating Delivery Managers 
• Editing Delivery Managers 
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 Alternative Editor 

 
 
Introduction 
 
The Alternative Editor allows the user to specify which instances of LAWS Modules will 
used in a particular Alternative.  This feature also allows to user to easily create new 
Alternatives for comparisons. 
 
Basic Editor Functionality 
 

Alternative menu commands: 
 

Name Function Keyboard 
Shortcut 

 New Create a new Alternative Ctrl + N 
 Save Save the changes made in the editor Ctrl + S 

Rename Rename the Alternative current displayed in the editor   
Delete Delete the Alternative currently displayed in the editor from 

the current Project 
 

Close Close the editor dialog.  If changes were made, a Save 
Changes dialog will display. 
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Help menu commands: 
 
Name Function Keyboard 

Shortcut 
Help Displays the Alternative Editor's help information in the LAWS 

online Help window 
 

 
Alternative Selection: 
 
The Alternative Editor allows a user to browse through all the Alternatives created in the 
Project.  The name of the current Alternative appears in the Name field. To view other 
Alternatives, use the scroll buttons to the right of the name field or select the Alternative's 
name from the Name dropdown list.  The following table describes their functionality: 
 
Button Function 

 
 

 
View first record 
 

 View previous record 
 

 Current record displayed out of total number of records 
 

 View last record 
 

 View next record in the list 
 

 
Description: 

 
The Description field displays the description for the current Alternative.  The 
description can be edited by typing in the field.  A text window is available through the 
eclipse  button in the text-field.   

 
Button Panel: 
 

Button Function 

 
Save the changes made and close the editor 

 
Save the changes made 

 
Do not save the changes made and close the editor 

 
 
Specific Editor Functionality 
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Modules Tab: 
 
On the Module tab of the Alternative Editor select the Modules you would like the 
Alternative to use.  Currently the following Modules are needed to create a complete 
Alternative: 
 

• Land Module 
• Non-agricultural Land Module 
• Crop Management Module 
• Flow Network 
• Atmospheric Module 
• Water Management Module 

 
Each Module contains a dropdown list of their previously created types.   If needed, New 
Modules can be created using the corresponding New button.  The Non-agricultural Land 
Module is an optional module that only has to be used if groundwater is being modeled.   
 
Run Controls Tab: 
 

 
 
Start Date and End Date: 
 
The Run Controls tab contains editable information on the model's run commands.  The 
time window for the Alternative run is entered in the Start Date and End Date.  The date 
fields require the DDMMMYYYY date format; for example, 01JUN1999.  The dates 
may be entered manually or using a Calendar Tool accessed through the ellipse  
buttons in the Start Date and End Date text fields.  
 
Compute Water Quality: 
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Checking this box enables the water quality calculations in LAWS.  For a complete 
description of the water quality calculations please see the Technical References section 
documentation. 

 
Log Level: 
 
The Log Level represents the detail and quantity of error messages reported by the 
compute engine.  This can be very useful when trying to debug an unsuccessful run.  The 
higher the Log Level number, the more messages will be logged during the compute. 
Messages are written to the Compute's Message Pane and the application log file.  The 
Default Log Level is 0.   
 
Write Land Manager ASCII Output File: 
 
The LAWS output to this ASCII file for Land Managers can become extremely large if 
there are multiple Land Managers in the Land Module assigned to the Alternative.  If the 
Land Manager Summary is not needed, this option can be turned off by unselecting the 
checkbox.  Then the Land Manager output file will not be written during the compute. 
 This option is unchecked by default. 

 
Write Delivery Manager ASCII Output File: 
 
The LAWS output to this ASCII file for the Delivery Managers can become extremely 
large if there are multiple Delivery Managers in the Water Management Module assigned 
to the Alternative.  If the Delivery Manager Summary is not needed, this option can be 
turned off by unselecting the checkbox.  Then the Delivery Manager output file will not 
be written during the compute.  This option is checked by default. 

 
 

Initial Condition Tab: 
 

 
 

The Initial Condition tab displays a table of model variables that require an initial 
condition.  These include reservoir storage and reservoir water quality if the Compute 
Water Quality option is selected. 

 
Input Time Series Tab: 
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The Input Time Series tab displays a table of variables for which input time series must 
be specified.  These time series inputs use the U.S. Army Corps of Engineer's HEC DSS 
data format.  For more information on this data format see 
http://www.hec.usace.army.mil/software/hec-dss/hecdss-dss.html.  LAWS includes  the 
HEC DSSVue tool which can be accessed from in the Tools menu, It can be used to 
import spreadsheet and text data and output the data in the HEC DSS data format. 
 
The following is a description of each column in the Table: 
 
Location - The Location refers to the data component that references the variable.  For 
example:  The Precip variable, in the second row of the table displayed above, belongs to 
the Atmospheric Module CIMIS's Met Station. 
 

• Variable - The name of the variable.   
• DSS File - Either the full path name to the dss file assigned to the variable or the 

relative path to the project's directory. 
• A Part - The A Part or first part, of the dss record's pathname.  Normally named 

after the general location were the data was collected.  For example: the river or 
reservoir name 

• B Part - The B Part or second part, of the DSS record's pathname.  Usually the 
more specific location of the A Part name.  For example: the section of the river 
or reservoir. 

• C Part - The C Part or third part, of the DSS record's pathname.  Typically named 
after the data type contained in the record. 

• D Part - The D Part or forth part, of the DSS record's pathname is the data's time 
step.  For example: 1DAY, 1HOUR, etc. 

• F Part - The F Part or fifth part, of the DSS record's pathname.  There is no 
convention for this part of the pathname, but it usually contains a more detailed 
description of the data. 

 
The variables listed in the Location column require DSS time series records as input.  To 
assign a DSS file and pathname to a variable: 
 

1. Select the variable's row, then click the Browse DSS Paths button.  The DSS 
Browser will appear.  

2. To open a DSS file, select File-> Open on the menu bar.  A File Browser will 
display.   

3. Using the file browser, select a DSS file. 
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4. Once a DSS file is chosen, the file's pathname parts will fill in the DSS Browser.   
5. Choose a pathname for your variable by highlighting a path in the list. 
6. Click the Set Pathname button to assign the path to the variable. 
7. The pathname will be displayed in the variable's row back on the Input Time 

Series tab's Table. 
8. To select another variable pathname, leave the DSS Browser on.   
9. Click on the Alternative Editor to set it active.   
10. On the Input Time Series tab of the Alternative Editor highlight a variable's 

row.   
11. Return to the DSS Browser by clicking on it. 
12. Repeat steps 5 through 7. 

 
The following is a list of current variables that may require dss input: 
 

• Met Station ETO 
• Met Station Precip 
• Precip Water Quality 
• Reservoir Storage 
• Reservoir Instream Flow Requirement 
• Delivery Manager Groundwater Minimum Use 
• Delivery Manager Groundwater Maximum Use 
• Delivery Manager Groundwater Quality 
• Other Supply (in the Delivery Manager Editor) Transmission Capacity 
• Other Supply (in the Delivery Manager Editor) Water Quality 
• Urban demand distribution factor 

 
 

Additional Information: 
 

• Alternatives 
• Creating an Alternative 
• Editing Alternatives 
• Running Alternatives 
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Additional Tools 
Additional LAWS Tools include: 
 

• Calendar 
• Memory Monitor 
• Default Map Properties 
• Options Dialog 

Calendar Tool 

 
 
 
The Calendar Tool is available in for variables to which dates need to be assigned.  It is 
usually accessed through an eclipse button  that appears in the text field when the field 
is double-clicked in.  The Calendar Tool allows you to easily view and select dates.  Use 
the back  and forward  buttons to scroll through months and years.  To select a 
date, highlight a numbered day square (27 is selected in the picture above) on the 
calendar and click OK.  The date will fill the text field using the correct format. 
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Memory Monitor 
 

 

 

The Memory Monitor is a real-time graphical representation of the amount of memory 
used by the application.  This tool is mainly used by the development team to spot 
potential problems within the application. 
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Default Map Properties 

 
 
 
The Default Map Properties editor contains information and settings for the Map 
Schematic's display area.  It allows you to adjust these settings, change the coordinate 
system, and assign default maps.  There must be an open Map Schematic window to 
access this editor.  Once a window is open, select the Project menu on the Menu Bar 
then Default Map Properties.  
 
Map Extents Tab 
 

On the Map Extents tab the viewing area (Map Extents) and coordinate system can 
be changed. 

 
Coordinate System: 
 
The coordinate system can be changed by using the Map Coordinate Information 
editor accessed through the Edit... button located next to the Coordinate System text 
field.  The current coordinate systems supported are: 
 

• X-Y 
• Geographic 
• Universal Transverse Mercator 
• State Plane Coordinates 
• Albers Equal-Area Conic 
• Lambert Conformal Conic 
• Transverse Mercator 
• Albers Equal-Area Conic (SHG) 
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• Polar Stereographic (HRAP) 
 
Each coordinate system has additional information which may be changed to suite 
your map needs.  Selecting a particular system will display the editable information. 
 For example, by selecting Geographic you have access to units used, Radian, Seconds 
of Arc, or Degrees of Ar. 
 
Map Extents 
 
The Map Extents sets the map area of the project displayed within the Map 
Schematic window.  Easting Minimum and Maximum values represent the West and 
East view respectively for the selected coordinate system.  Northing Minimum and 
Maximum values represent the South and North view respectively.  By default the 
Grow to Map Extents is selected to let these values grow or shrink according to the 
union of the extents from the maps assigned in the project.  To view these map 
extents, click the Set Map Extents to Display button.  The Easting and Northing 
areas will fill out with the current extents.  Alternatively, the option can be turned off 
by unselecting the Grow to Map Extents checkbox and you can manually enter the 
extents.   
 
 

Default Map Tab 
 
Existing project maps can be selected to display in the Map Schematic through the 
Default Map Tab.  To select a map to display, click the checkbox next to the map's 
name in the list of available project maps.  More than one map can be set to display. 
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Options Dialog 
The Options Dialog allows access to Application specific settings, variables, and 
program information. Through this dialog you to customize specific Application 
behavior.  Each tab is described below in detail. 
 
General Tab 
 

 
 
The General tab contains settings for how the LAWS application handles Projects. 
 Clicking a checkmark next to the description will set the option active. The following 
options are available: 
 

• Load Last Project at Startup - On initially opening the LAWS program, the last 
Project opened in LAWS will be loaded and displayed in the Project Tree. 

 
• Show Startup Screen - The Startup Screen is the initial screen displayed when 

the LAWS program is started.  It displays the LAWS icon, version date and 
number, and production information.  This screen is also viewable through the 
Help -> About LAWS menu option from the main Menu Bar. 

 
• Automatically Save Project on Exit - This option will save any changes made to 

the open Project before exiting the program. 
 

• Restore Layout - The Layout of the Map Schematic area will be restored when 
the LAWS program is restarted.  For example:  If the Map Schematic windows 
are set to display as panes in the Map Schematic Area, the next time you open 
multiple windows they will display as panes. 
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• Sync Project Tree to Map Window - Synchronizes Project and Maps 

 
• Project Save Interval (in minutes) - Setting a number in the decimal field of this 

option will have the program automatically save the open project every <number> 
of minutes. 

 
 
System Properties Tab 
 

 
 
The System Properties tab lists all the LAWS programs runtime variables.  These 
variables are set at the startup of the application and should only be changed if directed 
by a knowledgeable LAWS user or programmer.  Otherwise, do not change these 
settings!!! 
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Threads Tab 
 

 
 
The Treads tab is another programmer tool.  It displays information to calls inside the 
code and is not editable.  
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Output Displays 
 
Currently LAWS provides several ways to view output: 
 

• Summary Reports 
• Plots 
• Animations 

 

Summary Reports 
 

Area and Delivery Manager Monthly Summary 
 

Delivery Manager Monthly Summary report provides outputs for Area and Delivery 
Manager water budget components.  The variables contained in the outputs are 
indicated in the Table below. 

 
 

Delivery Manager Monthly Summary 
 Alternative 

Node Context 
Menu Option 

Monthly totals for Area and Delivery Managers values 

View Delivery 
Manager 
Monthly 
Output 

 
• Total Area 
• Canal Evap 
• Canal Seepage 
• GW Pumping 
• DW Recycled 
• Consumption Use 
• RZ Flow to GW 
• RZ Flow to DW 
• Irrig Tailwater 
• Ponded Water 

Runoff 
• Total DW Inflow 

 
• DW Evap 
• DW Flow to GW 
• DW Available for Recycling 
• Target DW Recycling 
• DW Imported 
• DW Exported 
• DW Returned 
• Total LM Request 
• Net Canal Request 
• Pending Delivery 
• AM Resvr Request 
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Area and Delivery Manager Daily Summary 
 

Delivery Manager Daily Summary report provides outputs for Area and Delivery 
Manager water budget components.  The variables contained in the outputs are indicated 
in the Table below. 
 

Delivery Manager Summaries 
 Alternative 

Node 
Context 
Menu 
Option 

Daily totals for Area and Delivery Managers 

View 
Delivery 
Manager 
Output 

 
• Total Area 
• Canal Evap 
• Canal Seepage 
• GW Pumping 
• DW Recycled 
• Consumption Use 
• RZ Flow to GW 
• RZ Flow to DW 
• Irrig Tailwater 
• Ponded Water 

Runoff 
• Total DW Inflow 

 

 
• DW Evap 
• DW Flow to GW 
• DW Available for Recycling 
• Target DW Recycling 
• DW Imported 
• DW Exported 
• DW Returned 
• Total LM Request 
• Net Canal Request 
• Pending Delivery 
• AM Resvr Request 
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Land Manager Daily Summary 
 

Land Manager Daily Summary report provides outputs for Land Managers' water budget 
components.  The variables contained in the outputs are indicated in the Table below. 
 

Land Manager Summary 

Alternative 
Node 

Context 
Menu 
Option 

Daily totals of Land Manager Values 

View Land 
Manager 
Output 

 
• Water Applied 
• Canal Delivery 
• GW Pumping 
• Rainfall 
• Total Water 

Loss 
• Application 

Loss 
• Runoff 
• RZ Inf 
• SWC After Inf 
• Crop Active 
• Crop Dead 
• RZ Depth 
• RZ SW Gain 
• ETO 
• Kc 
• ETC 
• RZ Drain 

Inflow 

 
• RZ Seepage 
• RZ Loss 
• SWC 
• SWC at MAD 
• RZ Storage Cap 
• Application Request 
• CV 
• CVAW 
• Depth Surface Pond 
• Pond Evap 
• Pond Inf 
• Pond Losses 
• SWC FC 
• SWC PW 
• HC 
• PH at FC 
• Application Eff 

 

 
 
 
Water Balance Summary 
 
Water Balance Summary report provides outputs of monthly and yearly water budget 
components.  The variables contained in the outputs are indicated in the Table below. 
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Water Balance Summary 
Alternative Node Context Menu Option Monthly and yearly totals 

 
View Water Balance Summary  

• Reservoir Net Flow  
• Reservoir Spill 
• Precip 
• Convey Loss 
• Channel Delry 
• GW Pumping 
• Drain Ruse 
• Deep Perc 
• Loss to Atm 
• Total CU 
• CU AW  
• Drain Return 
• Crops Planted 
• Crops Lost 

 
 
An example of creating a Water Balance Summary report is presented below.               
Summaries are available through the Alternative node's right-click popup menu.  The 
summaries display the total monthly values for a variety of variables computed for the 
time period.   

 
• View a summary by selecting View Water Balance Summary from the 

Alternative node's popup menu.  
 

  
 
 

TIP:  You can also use the Results menu to access the summaries. 
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TIP:  Use the scrollbars located on the right-side and bottom of the summary dialog to 
view more data. 
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Plots 
Once an Alternative has been successfully computed, a user can access the resulting 
plots.  Plots are obtained by right-clicking context menus in the Graphic in the Map 
Schematic.  Below is a Table of available plots.   
 
  

Available Plots 
Graphic Popup Menu 

Option Name 
Plots  

Reservoir 
Plot Flow and 
Storage 

Displays two plots in the 
dialog.  One is Flow vs. 
Time, the other, Storage vs. 
Time 

 Plot reservoir 
Accounts 

The Reservoir Accounts 
Storage vs. Time 

Reaches Plot Flow Flow through the Reach vs. 
Time 

Junctions 
Plot Flow Flow through the Reach vs 

Time 

Delivery 
Manager 

Plot DM 
Request and 
Deliveries 

Delivery Manager's water 
requested and actual water 
delivery vs. Time 

 Plot AM Water 
Accounts 

Area Manager water 
account volumes vs. Time 

 

Plots are accessed through right-click context menus on specific graphics on the Map 
Schematic.  An example of displaying a Reservoir Storage and Flow Plot is provided 
below.   
 

• Select the Pointer Tool  in the Map Schematic. 
 
• Right-click on Reservoir1 and select Plot Flow and Storage from the popup 

menu. 
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• The Reservoir Flow and Storage Plot dialog will appear.  Play around with the 

plot.  Use the Zoom Tool to get a closer look at the data.  Place the mouse over 
the plot line.  Explore the menu options.  When you're done, close the Plot 
window. 

 
• Right-click on other graphics in the map and locate more plots. 
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Animation  

Viewing Animation Results 
 
The use of the animation tool is illustrated with the following example.  In this case two 
Alternates are compared. The animations are defined by color variations in crops growing 
in the Land Managers, which change with each time step.  
 
Both Alternatives are opened in separate Map Schematic windows.  The first Alternative, 
BaseAlt, is already be displayed in a Map Schematic window.  The Alternative is opened 
by double-clicking on the BaseAlt2 node in the Alternative Module located in the Project 
Tree Pane. 
 
A Select Map dialog should appear. 
 

• In the Select Map dialog, click the New Map Window radio button and then 
click OK. 

 
• The BaseAlt2 Alternative will appear in a new Map Schematic window. 

 
Display the two alternatives side-by-side. 
 

• Select Window -> Tile in the main LAWS menu bar.   
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To Animate Results: 

  
• Select the Land Module Display Properties Tool  on the main LAWS 

Toolbar.  The Land Module Display Properties dialog will display. 
 

 
                           

 
• The model properties available for animation are listed on the left side of the 

Land Module Display Properties dialog.   
 
• Select the Crop Types property and click OK. 
 
• Notice a color legend appears in the Map Schematic.  The legend indicates a color 

for each Crop Type.  As the results are animated, the Land Managers will change 
color according to the Crop Type's assigned growing at each the time step. 
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• Select the next Alternative's Map Schematic window and add a Legend to it by 
repeating the steps above. 

 
 
Animate both windows at once. 
 

• Click on the Animation Tool  on the main toolbar. 
 
• The Animation Results dialog appears. 

 

 
 
• The dialog functions similar to a VCR.  There is a play button, fast forward 

button, etc. 
 

• Click on the play  button.   
 

• To speed up the play, click the fast-forward  button. 
 

TIP: You can also speed up the play be increasing the Play Delays in the Set Delays 
dialog.  To access this dialog select Configure -> Delays in the Animation Results 
dialog. 
 
As the slider moves along in time, the color variations on the Land Managers will change 
according to there output values at the time step. 
 

• Continue exploring different variables in the Land Module Display Properties 
dialog.  

 
TIP: The only variables that show color variation when played are those with the gear 
icon  next to them.  
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Technical Reference 
The following Technical Reference section presents background information on the 
concepts, methods and assumptions employed in the LAWS V2 Model. 

Introduction 
The Land Atmosphere Water Simulator (LAWS) is a tool designed for the management 
of large-scale, multi-organizational water supply systems.  LAWS differs from other 
water management models in several significant ways.  

First, LAWS simulates daily, field-scale land, crop, and water management practices. It 
provides users with tools to simulate alternative methods for managing soil moisture on a 
daily basis during the irrigation season based on soil properties, crop type and growth 
stage.  This approach permits LAWS to compute evapotranspiration, soil water content, 
surface water ponding, runoff, canal and drain losses, return flows to rivers, and deep 
percolation to groundwater at level of spatial and temporal resolution not present in 
existing planning and operations models.  Although LAWS performs these calculations at 
the field scale, LAWS also provides users with ability to aggregate these results within 
larger user definable areas so that water budgets can be readily computed for arbitrary 
organizational regions.  

Second, LAWS does not solve any governing flow equations except continuity nor is it 
an optimization model. However, LAWS V2 does offer several capabilities not typically 
found in most water resource system operations models. These features include the 
ability to simulate soil evaporation and crop transpiration as separate components of 
evapotranspiration, effects of soil moisture content on crop transpiration, crop rotations 
and root zone dynamics, effects of unsaturated flow on infiltration and runoff, effects of 
irrigation on water quality and effects of groundwater pumping on aquifer water levels 
and stream seepages.  These effects are all simulated using analytical functions as 
opposed to numerical methods.   This approach allows LAWS to be very computationally 
efficient but it requires the LAWS user to provide key input data from other sources of 
information such as field studies, remote sensing, GIS databases, physical process 
models, and expert judgment. In some instances such as for unsaturated flow soil 
properties and groundwater simulation, LAWS provides tools to assist the user in model 
parameterization. Although LAWS provides users with multiple methods for allocating 
water supplies and making priority based delivery decisions, LAWS does not employ any 
mathematical methods to determine what is the "best" allocation of water. In contrast, 
LAWS provides users with a powerful graphical user interface (GUI) that allows users to 
readily change water allocation and delivery priorities, land and crop management 
practices, and infrastructure characteristics to compare the effects of alternative system 
configurations on reservoir water supplies.  
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Third, LAWS has a native GIS capability built directly into the GUI. This GIS capability 
allows users to setup and analyze spatially accurate LAWS simulations across a span of 
scales ranging from large regional watersheds to sub-regions contained with individual 
fields.  LAWS also provides users with the capability to import imagery, maps, and GIS 
information developed with commercially available software packages. Furthermore, 
LAWS has been developed from the Corp of Engineers Water Management System 
(CWMS) software from which it has inherited a powerful suite of tools to examine model 
outputs including side by side comparisons of outputs from multiple alternative 
simulations and animations of spatial and temporal time series results. 

 

System Manager 
LAWS captures both the spatial and hierarchical organization of a water supply system. 
In LAWS, the supply system is conceptualized as a series of nested spatial units that 
range in size from multi-regional watersheds to individual land units as small as fields. 
The largest scale land area is associated with a System Manger (SM).  In a LAWS 
simulation, there may be one or more SMs.  At the next smaller spatial scale, each Area 
Manager (AM) manages a particular region within the system.  Within these regions, 
there are one or more Delivery Managers (DM).  These DMs represent sub-regions 
within the AM region where water management is performed differently based on some 
unique characteristics of the land or the water supply associated with the sub-region.  At 
the smallest scale, an individual land unit is represented by a Land Manager (LM).  Each 
LM is located within a single DM sub-region.  In LAWS, the geospatial locations of 
major reservoirs, rivers, canals and drains are explicitly located through its GIS capability 
down to the AM-scale. Although simulated mathematically, smaller scale conveyance 
infrastructure at the DM- and LM-scales is not explicitly geospatially referenced.  The 
LAWS spatial organization is shown in Figure 1 below.  
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Figure 1. LAWS Spatial Organization 
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The LAWS hierarchical organization represents the basic structure for managing requests 
for water supplies and making management decisions necessary for determining the 
amounts of water to be released from reservoirs as well as the amounts of supply to be 
provided by groundwater pumping and drain water reuse by individual Land Managers. 
The LAWS hierarchical organization is presented on Figure 2 below. 
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Figure 2.  LAWS Hierarchical Organization 

Each SM operates one of more reservoirs which may be located on different rivers 
systems within a regional watershed.  Each reservoir consists of one or more accounts 
each of which is associated with a specific AM. The volume of water in each AM 
account is determined by a user specified percentage of the conservation pool.  The 
amount of water in the conservation pool is reset on annual basis during the course of a 
multi-year simulation.  The LAWS user has the option to allow an AM account to receive 
additional supply during a simulation in order to determine how much additional supply 
would be necessary to meet their water requirements over the simulation period. 

At each daily time step, the SM can use either a sequential or balanced allocation method 
to determine how much water to release from each of the reservoirs it manages.  In a 
sequential allocation the highest ranking account associated with a particular AM is fully 
depleted before the next highest ranking account is utilized.  In a balanced allocation, 
water from each reservoir account associated with a particular AM is utilized 
simultaneously in a user specified proportion.  If an account is completely utilized before 
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the simulation is complete, the balance allocation ratios are recomputed to reflect the 
relative weighting of the accounts that still have remaining water supplies. 

The total amount of the SM deliveries must be constrained by the available release 
capacity of the reservoir and the capacity of the downstream river channels to convey 
releases without causing flood damage.  Since LAWS is intended to work in conjunction 
with other water management models, the reservoir release capacity can be specified at 
every time step.  This approach permits LAWS reservoir releases to be constrained by 
other in-stream flow requirements that are not explicitly modeled in a LAWS simulation. 
This capability is accomplished by specifying a LAWS reservoir release capacity as the 
maximum physical release capacity minus the non-consumptive use flows that are 
released for other in-stream flow or water quality requirements.  Typically, these 
regulatory releases would be simulated with another model and a daily time series of 
maximum reservoir release capacities would be computed for a LAWS simulation. 

In LAWS, SM reservoir releases are delivered to AMs through an explicitly modeled 
network of rivers, canals, and drains.  The hydraulic properties of these conveyance 
system features are represented explicitly at user defined reaches along the channels.  The 
LAWS user specifies a maximum flow capacity for each reach and can simulate 
accretions and depletions in these reaches with simple gain/loss factors.  The transit time 
for water flowing through reaches is also specified by the user.  

It is important to recognize that LAWS does not solve the governing equations of flow in 
open channels.  LAWS simulates flow hydraulics and surface-groundwater interactions 
by using user specified factors.  Consequently, the LAWS user must develop this 
information from field studies, simulations using hydrodynamic and groundwater models, 
or expert judgment.  This simplistic approach used throughout LAWS avoids the 
computational overhead and complex data requirements of numerical models.  However, 
since LAWS is a mass conservative model, it can be used to determine water budgets 
from the regional-scale all the way down to the field-scale.  Further, the simplicity of the 
approach permits the LAWS user to efficiently compare alternative land and water 
management practices, infrastructure characteristics and configurations as well as water 
delivery priorities explicitly established at each level of the multi-organizational 
hierarchy. 

Area Manager 
A LAWS Area Manger is one of the four levels in the LAWS hierarchical organization. 
An AM represents an organizational unit that manages of water supplies for a particular 
spatial region within the water supply system.    In the LAWS hierarchy, an AM is the 
intermediary between a System Manager (SM) and the Delivery Managers (DM) which 
supplies water to individual Land Managers (LM).  

The AM manages one or more water accounts.  Each of these accounts is associated with 
a particular SM and has a specified maximum volume.  An AM may have accounts with 
multiple SMs and more than one account with the same SM.  The AM is responsible for 
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managing the use of its accounts during a simulation.  There are two account utilization 
mechanisms in LAWS.  In a sequential utilization operation, the highest priority account 
is used completely before water from the next highest priority account is delivered from 
reservoir storage.  In a balanced utilization operation, water from each account is utilized 
simultaneously in a user specified proportion.  If an account is completely utilized before 
the simulation is complete, the balanced utilization ratios are recomputed to reflect the 
relative weighting of the accounts that still have remaining water supplies. 

Although the SM determines the actual daily amounts of water released from an AM 
reservoir account, the AM is responsible for establishing the amounts of the groundwater 
pumping and drain water reuse to be used to meet consumptive use requirements within 
its DM sub-regions.  In LAWS, the total volume of ground water use is not absolutely 
constrained to a specified amount.  However, the amount of drain water recycling is 
limited to a user specified fraction of the total drain water inflow during each time step. 
These user specified factors represent the percentage of the total consumptive use 
requirement that is to be met from these sources of supply.  The groundwater pumping 
and drain water reuse factors are set by the user for each DM in the AM region at each 
time step.  In the event that the amount of drain water available for recycling is not 
sufficient to meet the AM target, groundwater pumping is automatically increased to 
make up for the deficit.  Since the groundwater pumping and recycling factors may be set 
to zero by the user, alternative simulations using only reservoir supplies may be readily 
performed for comparison with various pumping and drain water recycling alternatives.  

The AM is responsible for establishing the water delivery priorities that are to be 
implemented within its region.  LAWS employs a user specified hierarchical system to 
determine how water is delivered to individual LM within a DM sub-region.  The 
application delivery logic is designed to be user extensible so that multiple factors such as 
seniority of water rights, types of crop, growth stage, moisture stress or other user defined 
criteria could be employed in the delivery decision logic in future versions of the model. 

 The AM is responsible for managing the DMs within its region.  At each time step, the 
AM must determine how much water to supply to each of its DMs.  After receiving 
deliveries for each of its accounts from one or more SMs, the AM may use one of three 
different delivery priority mechanisms.  In a sequential delivery operation, each DM is 
given a fixed priority relative to the others in the AM region and the highest priority 
DM’s consumptive use requirement is completely satisfied before water from the next 
highest priority DM is delivered.  In a balanced delivery operation, delivery is made to 
each DM in a user specified proportion.  In hierarchical delivery operation, deliveries are 
to each DM based on the priority of individual LMs within the DM.  This mechanism 
essentially treats all DMs with equal priority but insures that LMs meeting the highest 
ranking in the highest hierarchical level are completely satisfied before lower priority 
water deliveries are made.  If a ranking is reached for which the remaining water supply 
is inadequate, a shortage delivery is made to the LMs in this ranking group. 

At each daily time step, the AM is responsible for receiving and accumulating the 
requests for water supplies from each of its DMs.  Using this request information, the 
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AM employs its account utilization methods to determine how much water to request 
from its various accounts.  The amounts of requests are adjusted to account for 
conveyance depletions/accretions and forwarded to the SMs associated with each of its 
accounts. 

Delivery Manager 
Within the overall structure of LAWS, the Deliver Manager serves as an intermediary 
between the Land Manager (LM) whose function is to apply water to an individual land 
unit and the Area Manager (AM) that requests and distributes water received from the 
System Manager (SM).  Each DM is associated with a single AM and operates to meet 
requests for water from multiple LMs.  

At each time step, the DM is responsible for accumulating the amounts of water 
requested by each of its LMs.  After all the LMs’ application requests have been 
received, the DM has the responsibility for determining an appropriate amount of water 
to request from its AM to meet the needs of all the land units within its sub-region. 

In order to determine the amount to request, the DM takes into account a number of 
physical and management factors impacting water use within its sub-region.  The 
physical factors include conveyance losses from canals, inflows and outflows associated 
with adjacent DM sub-regions, deep percolation to groundwater, as well as various 
inflows and outflows from drains.  Management factors include the desired amount of 
groundwater pumping and drain water reuse within the DM’s sub-region. The water 
budget components of the DM system are shown on the Figure 3 below. 
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Figure 3 Delivery Manager Water Budget Components 
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It is important to recognize that the canals and drains within a DM sub-region are not 
explicitly represented as physical features within a LAWS model.  The DM canals and 
drains represent the affect of field scale canals and drains on the overall water budget 
within the sub-region.  This approach allows simulation of a sub-region’s water balance 
without the difficult and time consuming task of explicitly accounting for all field-scale 
infrastructure typically found in a water delivery system.  At the same time, this approach 
allows users ample flexibility to investigate the important effects these features exert on 
the amount the water needed to meet consumptive use requirements. 

During each time step, the three major functions of a DM are to deliver to the LMs the 
water received from the AM, receive water application requests from LMs and determine 
an appropriate amount of water to request from the AM in the next time step.  It is 
important to recognize that the actual amounts of water received from the AM for 
delivery to the LMs may be less than the amount requested.   

At each time step, the AM establishes the deliver priorities within its region and notifies 
each DM of the supply available for delivery.  The total amount consists of reservoir 
releases, groundwater pumping, and recycled drain water.  Using the delivery priorities 
established by the AM, the DM delivers water to all the LMs for which sufficient supply 
is available.  

 As the DM delivers water, LMs inform the DM of any unmet water needs by making an 
application request for whatever amount is still required for consumptive use based on 
the final soil water content after delivery to the land unit.  Once all the possible deliveries 
have been made, the DM queries the remaining LMs to determine their application 
requests.  This process insures that every land unit is queried and results in the soil water 
content and other water budget components of every land unit being updated at every 
time step. 

After the DM has completed the delivery process, the total amount of all LM application 
requests is known.  The DM must now determine the total amount of water to request 
(DIV) for the entire sub-region.  This process involves accounting for gains, losses and 
reuse of water within the sub-region.  In addition to water supplied by the AM, other 
sources of supply to the DM sub-region include inflows into canals from adjacent sub-
regions (IOR) and groundwater pumping (GWP).  Other than consumptive use of applied 
water (CUAW), losses from the sub-region include canal seepage (CLS), drain seepage 
(DLS), and deep percolation (DP) to groundwater, evaporation from canals (CLA) and 
drains (DLA) to the atmosphere, outflows from drains to adjacent sub-regions (DOR) and 
return flow from DM drains to AM drains (DRTN).  Tail water losses (TWL) and drain 
water reuse (DWR) within the DM’s sub-region are other user defined management 
factors that affect the amount of water the DM requests from the AM. 

At each time step, the DM employs results from the LMs to compute the sub-region’s 
consumptive use of applied water and its application efficiency factor (AEF).  To perform 
these calculations, the DM uses the following results from each LM. 
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1. Amount of the application request (AAR ) 
2. Consumptive use requirement (CUR) 
3. Root zone losses to drains (RLD) 
4. Root zone losses to seepage (RLS) 
5. Rainfall and pond runoff to drains (RFO) 
6. Tail water losses (TWL) 
7. Land Unit Application Efficiency (LUEF) 
8. Land Manager Area (AREA) 

 
Calculation of the amount of water to request from the Area Manager requires the 
following totals from the Land Managers associated with each DM. 
 
Sum of the land manager Application Amount Request, TAAR 
Sum of the land manager Drain Inflow, DINF 
Sum of the Drain Inflow from Other Regions, DIOR 
 
The DM’s TAAR is equal to Net Canal Delivery (NCD) plus Groundwater Pumping 
(GWP) plus Local Drain Water Reuse (DWR) 
 

TAAR = NCD + GWP + DWR 
 

The Canal Inflow (CIN) is equal to the Area Manager Delivery (AMD) 
 

CIN = AMD 
 

The Net Canal Delivery is the Canal Inflow less Canal Losses to Atmosphere (CLA) and 
Canal Losses to Seepage (CLS), which are fractions of the total canal inflow 
 

NCD = CIN – CLA – CLS 
NCD = CIN*(1-CLAF-CLSF) 
NCD = AMD*(1-CLAF-CLSF) 
 

Groundwater Pumping Factor (GWPF) is used to determine groundwater pumping 
 

GWP=TAAR*GWPF 
 

Drain Water Reuse Factor (DWRF) is used to determine Target for Drain Water Reuse 
(TDWR).  Note that there may not be enough local drainage to meet the target! 
 

TDWR = TAAR*DWRF 
 

LAWS determines the Drain Water Available for Reuse (DWAR) based on the total drain 
water less losses to atmosphere (DLA) and seepage DLS) and exports to other Delivery 
Managers (DEXP) 
 

DWAR=DINF+DIOR-DLA-DLS-DEXP 
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DWAR=DINF*(1-DLAF-DLSF-DEXPF)+DIOR 
 

If DWAR is greater than or equal to TDWR, then we meet the objective and the DWR is 
equal to the target, and the Drain Water Return Flow (DWRTN) is the difference 
 

DWR = TDWR 
DWRTN=DWAR-DWR 
 

If DWAR is less than TDWR, then the DWR is equal to the available drain water, and 
there is no return flow 
 

DWR=DWAR 
DWRTN=0 
 

The Area Manager Delivery, AMD, is computed as follows. 
 

TAAR = NCD + GWP + DWR 
TAAR= AMD*(1-CLAF-CLSF)+ TAAR*GWPF+DWR 
AMD=(TAAR*(1-GWPF)-DWR)/(1-CLAF-CLSF) 
 

The DM calculates the total amount of deep percolation (DPG) traveling to groundwater 
table at each time step from results of the LM calculations and the results described 
above. 
 

 
 
Unless the groundwater module is employed, LAWS V2 does not include the physical 
processes needed to determine the rate of subsurface flow or resultant changes in the 
elevation of the water table. 

Land Manager  
Within the overall structure of LAWS, the role of the Land Manager (LM) is to apply 
water received from the Delivery Manager (DM) to the land, determine the soil moisture 
content after application and request an appropriate amount of water from the DM 
depending on the status of the soil water content.   
 
In LAWS V2, soil water flow is simulated using a 1-dimensional 2 layer model to 
calculate bare soil evaporation, plant transpiration, surface water runoff, infiltration, 
groundwater table upflux, and deep percolation.  Infiltration into the soil profile is 
simulated using a 1-dimensional unsaturated flow analytical equation (Philip, 1957).  Soil 
evaporation and plant transpiration are computed using the well known dual crop 
coefficient method. Upflux and deep percolation are also computed by accounting for the 
effects of variable saturation in a dynamically changing root zone. These results are used 
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to determine the soil moisture content at each daily time step.  When the soil moisture is 
reduced to a user specified management allowable depletion, the LM notifies the DM that 
delivery of additional water is required.  Since certain crops and management practices 
require ponding of water on the soil surface, a provision is made to manage water under 
both ponded and unponded conditions. The effects of irrigation on changes in a non-
reactive, conservative constituent can also be simulated. The details of these calculations 
are provided below. 
 
Soil moisture flow is modeled in LAWS using a 1-dimensional 2 layer model that 
calculates bare soil evaporation, plant transpiration, surface runoff, infiltration, 
groundwater table upflux, and deep percolation (Figure 1).  Evaporation and transpiration 
are modeled using the dual crop coefficient approach described in Food and Agriculture 
Organization Irrigation and Drainage Paper 56 (Allen, et al, 1998), hereafter referred to 
as FAO 56.  The top layer of the model is layer 1 or the bare soil evaporation layer as 
described in FAO 56.  The bottom layer is the remainder of the root zone and increases in 
depth as the plants mature.   
 
 

 
Figure 1.  Schematic of two layer soil water balance model. 

 

Bare soil evaporation 
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Bare soil evaporation is calculated using the method described in FAO 56.  It removes 
water from the “evaporation layer” or layer 1 which has thickness Ze which is specified 
by the user in the Soil Type Editor. 
 

Es = Ke*ETo  Eq.  1 
 
Es - evaporation from bare soil (L/T); 
Ke - soil water evaporation coefficient; 
ETo - reference evapotranspiration (L/T). 

Soil water evaporation coefficient, Ke: 

Ke = MIN[Kr (Kcmax-Kcb), few Kcmax] Eq.  2 
 
Kr - soil water evaporation reduction coefficient; 
Kcmax - maximum value of the climate adjusted crop coefficient; 
Kcb - basal crop coefficient; 
few -  fraction of soil surface that is wetted and exposed. 

Soil water evaporation reduction coefficient, Kr: 

Kr is a function of the soil water content in the evaporation layer (θse) and the soil 
physical properties: 
 
If  θse > θREW then Kr =1, if θse < θREW then  
 

TEWREW

SEREWKr
θθ
θθ

−
−

−= 1   Eq.  3 

 
where bare soil evaporation is described by the simple model mentioned above and 
illustrated in Figure 2. 
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Figure 2.  Bare soil evaporation model.  Kr is a function of soil water content.  For θse 
greater than θREW the atmospheric conditions are the limiting factor on evaporation rate.  
For θse less than θREW the evaporation rate is limited by the soil physical properties. 
 
θse - soil water content in evaporation layer; 
θs - soil water content at saturation; 
θFC - soil water content at field capacity; 
θREW - soil water content at limit of "readily evaporable water" (REW); 
θWP - soil water content at wilting point; 
θTEW - soil water content at limit of “total evaporable water”, note is assumed to be θTEW 
= 0.5 θWP. 

 
Information on determining the value of REW can be found in FAO 56, Table 19, p. 144.  
Its value is specified in the Soil Type Editor.  Generally, the thickness of the evaporation 
layer, Ze, ranges between 10 and 20 cm. 
 

Maximum crop coefficient, Kcmax 

 
Kcmax = MAX[{1.2 + [0.04(u2-2) – 0.004(RHmin-45)](h/3)0.3},{Kcb+0.05}] 

 Eq.  4 
 
 
Kcmax - upper limit on evaporation and transpiration; 
u2  - seasonal daily average wind speed at 2 m height (m/s); 
RHmin - mean daily minimum relative humidity (%); 
h - seasonal maximum plant height (m). 
 
u2, RHmin, and h are specified in the Crop Type Editor. 
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Fraction of soil surface that is wetted and exposed, few 

 
few = MIN(1-fc, fw)  Eq.  5 

 
fw - fraction of soil surface wetted by the irrigation or rainfall event, this value is 

specified in the Irrigation Systems Type Editor; 
fc  - effective fraction of the soil surface covered by the vegetation canopy, this value can 

be entered into the Crop Type Editor or the following equation can be used. 
 

)5.01()
minmax

min( h

KcKc
KcKcbfc +

−
−

=   Eq.  6 

 
Kcmin - minimum value of Kc for a bare dry soil; 
Kcmax - maximum value for Kcb; 
h - plant height (m). 
 
Kcmin and h are specified in the Crop Type Editor. 
 
 

Plant transpiration 
 
Plant transpiration is modeled using the basal crop coefficient method described in FAO 
56. 
 

T = Kcb * ETo * f  Eq.  7 
 
Kcb - basal crop coefficient; 
f - soil moisture limiting factor. 
 
The basal crop coefficient is used to scale the reference evapotranspiration based on the 
development stage of the plant (Figure 3). 
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Figure 3.  Example of the basal crop coefficient. 
 
Kcb ini  - basal crop coefficient during the initial growth stage; 
Kcb mid - basal crop coefficient during the period during which the crop has reached full 

cover; 
Kcb end - basal crop coefficient at then end of the growing season. 
 
The values for the basal crop coefficient can be found in Table 17 of FAO 56 and are 
entered into the Crop Type Editor. 
 
The soil moisture limiting factor, f, reduces transpiration as a function of the soil pressure 
head. (Feddes et al.,1978).  Its form is shown on Figure 4 below. 
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Figure 4.  Transpiration limiting factor f as a function of matric potential. 
 
hWP  - pressure head at which the plant dies (cm); 
hc - pressure head below which transpiration is limited due to moisture stress(cm); 
hAN - pressure head l above which transpiration is limited due to anoxic conditions (cm); 
ho - pressure head at which transpiration ceases due to anoxia (cm). 
 
hwp is assumed to be -15,000 cm of pressure head.  hc is entered into the Crop Type 
Editor in the "Max Pressure Head for Full ET (L)" field.  hAN is entered into the Crop 
Type Editor in the "Min Pressure Head for Full ET (L)."  ho is assumed to be 0 cm of 
pressure head. 
 
 

Infiltration and runoff 
 
Daily maximum infiltration is modeled in LAWS using the 1-dimensionl Philip's 
equation (Philip, 1957). 
 

DMI = S*t1/2 + K*t  Eq.  8 
 
DMI - daily maximum infiltration (L/T); 
S - soil sorptivity (L/T); 
t - time (T); 
K - hydraulic conductivity which is assumed  to be the saturated value - Ks (L/T). 
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The soil sorptivity is calculated using the following equation. 
 

2/11 ]
)(2

[
β

θθ cmStS HK
S −−
=   Eq.  9 

 
θs  - saturated moisture content; 
θt-1 - average root zone moisture content at end of previous time step; 
Hcm - effective capillary drive; 
Β - viscous correction factor (ranges from 1.1-1.7), in LAWS it is assumed to be 
1.3.  
 
Using the derivation of the effective capillary drive found in Morel-Seytoux, et al. 
(1996). 
 

2

32

167.41
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++
=

α    Eq.  10 

where: 
 
α - van Genuchten parameter (1/cm); 
m - = 1-1/n, where n is a van Genuchten parameter.  
 
Using the Philip equation, the maximum daily infiltration can be calculated.  Rainfall or 
irrigation in excess of the daily maximum infiltration and user defined pond depth is 
assumed to be runoff.  The following algorithm is used in the LAWS model. 
 
If R + I + PondDt-1 > DMI Then 
    If R + I + PondDt-1 > DMI + MaxPondD Then 
 Runoff = R + I + PondDt-1 – DMI – MaxPondD 
 PondDt = MaxPondD 
 Infil = DMI 
    Else 
 Runoff = 0.0       Eq.  11  
 PondDt = R + I + PondDt-1 - MaxInfil 
 Infil = DMI 
    Endif 
Else 
    Infil = R + I + PondDt-1 
    Runoff = 0.0 
    PondDt = 0.0 
Endif 
 
where: 
 
R - rainfall (L/T); 
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I - irrigation water applied (L/T); 
DMI - daily maximum infiltration (L/T); 
Runoff  - surface runoff (L/T); 
Infil - infiltration (L/T); 
PondDt-1 - depth of ponded water from previous time step (L); 
MaxPondD - maximum pond depth (L). 
 
 

Water Table Upflux 
 
In regions with a shallow water table, a portion of the crop water demand can be met 
from water that moves upward through capillary action to the root zone.  In LAWS, this 
process is modeled using a Darcy’s Law approach. 
 
To calculate water table upflux into the bottom layer, the gradient between the water 
table and the mid-point of the bottom layer is calculated.  The soil between the water 
table and this layer is assumed to be at field capacity and the hydraulic conductivity is set 
accordingly.  The ground surface is used as the datum.  In LAWS, the field capacity is 
assumed to be at -1/3 bar pressure head or -333 cm of water pressure. 
 

2/
)2/()()(

RZWT

RZRZWTWT
FC ZZ

ZhZhhKUpflux
−

−−−
=   Eq.  12 

where: 
 
Upflux  - flux of water from water table into root zone (L/T); 
K(hFC) - unsaturated hydraulic conductivity at field capacity (L/T); 
hWT - pressure head at water table surface (= 0.0 cm); 
ZWT - depth of water table below ground surface (cm); 
hRZ - average pressure head in root zone (cm); 
ZRZ - thickness of root zone (cm); 
ZRZ/2 - depth of mid-point of root zone (cm). 
 
 
Water can also flow up into the evaporation layer due to capillary forces. This flux is 
calculated in a manner similar to the Upflux. 
 

2/2/
)2/()2/()(

ERZ

EERZRZ
RZ ZZ

ZhZhhKEUpflux
−

−−−
=   Eq.  13 

 
ZE/2 - elevation head at mid-point of evaporation layer (cm); 
EUpflux - flux of water from root zone into evaporation layer (L/T); 
hE - average pressure head in evaporation layer (cm). 
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Soil Moisture Routing 
 
The water balance in the soil layers is calculated as a sum of the inflows and outflows.  
The water balance equation used depends upon the relative magnitudes of the fluxes and 
storage from the previous time step.  Below, the equations are presented following a 
description of the conditions for which they are appropriate. 
 

Layer 1 (Evaporation Layer) 

Layer 1 - Case 1 

 
If the sum of infiltration plus upflux minus  evapotranspiration in Layer 1 is greater than 
the unsaturated pore space at the end of the previous time step (Infil+EUpflux-Es-TE /Ze 
> θs – θt-1), then soil water content during the current time step is calculated based on the 
following equations. (Williams et al., 2008): 
 

θ1
t = (θs – θFC) exp(-1/TT) +  θFC  Eq.  14 

 
θ1

t - soil moisture content in layer 1 at end of time step i; 
θs - soil moisture content at saturation; 
θFC - soil moisture content at field capacity; 
TE - transpiration from evaporation layer, TE = T*(ZE/ZRZ); 
TT - travel time (d), where: 
 
where: 

TT = Ze * (θS- θFC)/(Ks)  Eq.  15 
and  
 
Ze - thickness of evaporation layer (cm); 
Ks - hydraulic conductivity at saturation (L/T). 
 
Infiltration (InfilSS) into Layer 2 of the root zone is calculated as: 
 

InfilSS  = IN – OUT – ΔS  
 

where each of the terms in the equation are given in Eq.  16 below: 
 

InfilSS = (Infil+EUpflux) - (Es+TE) – ((θ1
t - θ1

t-1)*Ze)  Eq.  17 
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Layer 1 - Case 2 

 
If the infiltration plus upflux minus  evapotranspiration in Layer 1 results in a moisture 
content between saturation and field capacity (θs > (Infil+EUpflux-Es-TE)/Ze + θi-1 > 
θFC), then the new soil water content and infiltration into Layer 2 are calculated by 
Equations 15, 17 and 18. 
 

θ1
t = ((Infil+EUpflux-Es-TE)/Ze + θ1

t-1 – θFC) exp(-1/TT) +  θFC  Eq.  18 
 
Infiltration into Layer 2 of the root zone is calculated as: 
 

InfilSS  = IN – OUT – ΔS  
 

where each of the terms in the equation are given in Eq.  18 below: 
 

InfilSS = (Infil+EUpflux) - (Es+TE) – ((θ1
t - θ1

t-1)*Ze)  Eq.  19 

 

Layer 1 - Case 3 

 
If the infiltration plus upflux minus  evapotranspiration in Layer 1  results in a soil water 
content less than field capacity ((Infil+EUpflux-Es-TE)/Ze + θt-1 ) < θFC), then the new 
soil water content and infiltration are calculated as: 
 

θ1
t = ((Infil+EUpflux-Es-TE)/Ze + θt-1)  Eq.  20 

 
Infiltration into Layer 2 of the root zone is calculated as: 
 

InfilSS  = 0  
 

Layer 2 (Root Zone Sub-Soil) 

 
The equations presented below illustrate the method used to calculate deep percolation 
and soil moisture changes in the portion of the root zone that is not in the evaporation 
layer.  The thickness of this layer is ZSS  = ZRZ – Ze. 
 
where  ZRZ is the root zone thickness during the current time step. 
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Layer 2 - Case 1 

 
If the infiltration plus upflux from the water table into Layer 2 minus plant transpiration 
and upflux from Layer 2 to Layer 1 is greater than the unsaturated pore space at the end 
of the previous time step ((InfilSS+Upflux-TSS-EUpflux/ Ze > θs - θi-1), then the soil water 
content during the current time step is calculated based on the following equations. 
 

θ2
t = (θs – θFC) exp(-1/TT) +  θFC  Eq.  21 

 
θ2

t - soil moisture content in layer 2 at end of time step i; 
Tss - portion of transpiration that occurs in Layer 2 assumed to be T * ZSS/ZRZ; 
TT - travel time (d), where: 
 

TT = (ZSS) * (θS- θFC)/(KS)  Eq.  22 
 
Zss - thickness of subsoil layer (L); 
Ks - hydraulic conductivity at saturation (L/T). 
 
Deep percolation (DP) from the Layer 2 is calculated as: 
 

DP = IN – OUT – ΔS 
  

where each of the terms in the equation are given in Eq.  22 below: 
 

DP = (InfilSS+Upflux) – (TSS +EUpflux) – (θ2
t – θ2

t-1)* ZSS  Eq.  22 
 

 

Layer 2 – Case 2 

If the sum of infiltration plus upflux into Layer 2 minus plant transpiration and upflux 
from Layer 2 to Layer 1 results in a moisture content between saturation and field 
capacity (θs > (InfilSS+Upflux-TSS-EUpflux)/ZSS + θ2

i-1 > θFC), then the soil water content 
and deep percolation from Layer 2 during the current time step are calculated by 
Equations 21, 23 and 24. 
 
 
θ2

t = ((InfilSS+Upflux-TSS-EUpflux)/ZSS + θ2
i-1 – θFC) exp(-1/TT) +  θFC  Eq.  23 

 
 

 
Deep percolation from Layer 2 is calculated as: 
 

DP = IN – OUT – ΔS 
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where each of the terms in the equation are given in Eq.  24 below: 
 

DP = (Infil+Upflux) – (TSS+EUpflux) – (θ2
t – θ2

t-1)* ZSS  Eq.  24 

 

Layer 2 - Case 3 

 
If the infiltration plus upflux minus  evapotranspiration in Layer 1  results in a soil water 
content less than field capacity ((InfilSS+Upflux-TSS-EUpflux)/ZSS + θi-1 ) < θFC), then the 
new soil water and deep percolation are calculated as follows: 
 

θ2
t = (InfilSS+Upflux–TSS-EUpflux)/ZSS + θ2

t-1  Eq.  24 
 

DP = 0 
 

Irrigation Demand 
In LAWS, irrigation water demand is based on the amount of the soil moisture deficit 
when an irrigation event is requested by a Land Manager and the user specified 
distribution uniformity, DU.  Irrigation is requested when the soil moisture content of the 
root zone is less than the user specified management allowable depletion (MAD).  The 
irrigation demand is computed by: 
 

ID = (θFC – θRZ)*ZRZ/DU  Eq.  25 
 
where: 
 
ID - irrigation demand (L); 
θFC – θRZ - soil moisture deficit  
Zrz - root zone thickness 
DU - distribution uniformity. 
 
The Management Allowable Depletion (MAD) is defined as the fraction of the water 
content between field capacity and wilting point that is allowed for plant use prior to 
irrigation.  when the root zone moisture content is below θMAD irrigation water is 
requested. 
 

θMAD = (1-MAD)* (θFC – θWP)+ θWP  Eq.  26 
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Solution Method 
For each daily time step, the LAWS model performs the following operations in the order 
specified. 
 

1. Adjust water content from previous time step to account for increase in root 
zone thickness.  As the root zone increases in thickness, the average root zone 
moisture content must be updated to reflect the newly occupied soil.  This is done 
by adding the new depth increment into the moisture content calculations.  It is 
assumed that the new depth increment has a moisture content of field capacity. 

 
2. Calculate upflux from water table into Layer 2 and upflux from Layer 2 into 

Layer 1.  The equations presented are used to calculate the flow of water from the 
water table up into the Layer 2 and from Layer 2 into Layer 1. 

 
3. If irrigation or rainfall occurs, calculate infiltration, ponding depth, and 

runoff.  The irrigation or rainfall rate is compared to the Daily Maximum 
Infiltration rate (DMI).  If the irrigation and/or rainfall rates are in excess of the 
DMI and the user defined ponding depth, then runoff is produced. Surface 
watervrunoff becomes part of the Drain water budget. 

 
4. Calculate potential daily bare soil evaporation.  The potential daily bare soil 

evaporation rate is calculated using the procedure described.  In this step, the 
daily bare soil evaporation rate is calculated as a function of the soil moisture 
content from the previous time step.  However, if on that day irrigation or rainfall 
occurs the value of Kr is adjusted to account for the additional plant available soil 
moisture.  If the ponding depth is non-zero then the value of Kr is set to 1.0.  For 
rainfall events, the fraction of the soil surface that is wetted, fw, is set to 1.0.  For 
irrigation events fw is the user specified value. 

 
5. Calculate potential daily soil moisture limited transpiration.  The potential 

daily transpiration rate is calculated using the algorithm described. 
 

6. Calculate actual transpiration and soil evaporation for the day based on the 
available soil moisture storage.  Due to the length of the model time step, it is 
possible for the potential evaporation and transpiration rates to remove more 
water from the soil than is actually available.  To correct for this problem, logic in 
the model checks to see if there is enough moisture available to supply water at 
the calculated evapotranspiration rates.  If not, the rates are reduced so that only 
the available soil moisture is transpired or evaporated. 

 
7. Using the values calculated above, the change in soil moisture storage in 

Layer 1 and the infiltration of water into Layer 2 are calculated. 
 

8. Using the values calculated in steps 1 - 6, the change in soil moisture storage 
in Layer 2 and the amount of Deep Percolation are calculated. 
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9. If necessary, the soil moisture content is adjusted to account for the presence 

of the water table in the root zone.  The new root zone soil moisture content is 
calculated by averaging the soil moisture content over the saturated and 
unsaturated portions of the root zone. 

 
θRZ = ((ZRZ – ZWT)* θRZ + ZWT* θS θRZ)/ZRZ  Eq.  27 

 
10.  Calculate irrigation demand.  
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Modeling Water Quality in LAWS 

Introduction 
The LAWS V2 model has the capability to model a single non-reactive, mass 
conservative water quality constituent. This capability was designed to model 
constituents like total dissolved solids (TDS) which are commonly important to irrigation 
water quality.  Such constituents are also affected by plant transpiration and soil 
evaporation which remove water without a corresponding removal of salts. This 
capability can be activated by selecting the Compute Water Quality checkbox in the 
Run Controls tab of the Alternative Editor.   
 

Water Quality Model 
The water quality model employed in LAWS uses assumptions based on a non-reactive, 
mass conservative constituent.  Starting with reservoirs, the water quality of water exiting 
the reservoir is computed using the assumption of instantaneous mixing: 
 

RelWQ  = (Inflow * InflowWQ + ResVol(i-1) * ResVolWQ(i-1))/(Inflow + ResVol(i-1)) 
 
where:  
 
RelWQ - Water quality of water released by the reservoir during timestep i [M/V]; 
Inflow - Volume of inflow to reservoir during time step i [V]; 
InflowWQ - Water quality of reservoir inflow [M/V]; 
ResVol(i-1) - Volume of water storage at end of time step i-1 [V]; 
ResVolWQ(i-1) - Water quality of reservoir water at end of time step i-1 [M/V].   
 
As water flows downstream from the reservoir in stream reaches it can interact with the 
groundwater system.  Currently, the concentration of the water in the channel is assumed 
to remain constant. 
 
Upon arrival at a Delivery Manager (DM), the water is mixed with all other potential 
sources such as groundwater, recycled drain water, and other supplies.  The resulting 
mixed water is supplied to Land Managers. 
 
where: 
 
DelWatWQ = (RelWQ * RelDM + GWWQ * GW + DWWQ * DW + OSWQ * OS)/(Rel + GW + DW 

+ OS) 
 
DelWatWQ - Water quality of water delivered to Land Manager during timestep i [M/V]; 
RelDM - Volume of water released by reservoir for DM and delivered during timestep i 
[V]; 
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GWWQ  - Water quality of groundwater [M/V]; 
GW - Volume of groundwater pumped during time step i [M]; 
DWWQ  - Drain water quality [M/V]; 
DW - Volume of drain water used by DM during time step i; 
OSWQ - Other supply water quality [M/V]; 
OS - Volume of other water supplies used by DM during time step i [V]. 
 
Within a Land Manager, the quality of soil water is calculated using the following 
equation. 
 
LMWQ = (LMW(i-1) * LMWQ(i-1) + Infil * InfilWQ + Upflux * UpfluxWQ)/(LMW(i-1) + Infil + Upflux - 
E - T) 
 
LMWQ - Water quality of soil water in Land Manager at end of time step i; 
LMW(i-1) - Volume of soil water at end of time step i-1; 
LMWQ(i-1) - Water quality of soil water in Land Manager at end of time step i-1; 
Infil - Volume of water that infiltrates into root zone during time step i; 
InfilWQ - Water quality of infiltration water (same as DelWatWQ); 
Upflux - Volume of water that enters root zone as upflux from water table during time 

step i; 
UpfluxWQ - Water quality of upflux water; 
E - Volume of bare soil evaporation during time step i; 
T - Volume of plant transpiration during time step i. 
 

Data Input 
If the Water Quality option is selected, the user will be prompted in several of LAWS 
Modules to provide data related to the simulation of water quality. 
 

1. Alternative Editor - Initial Condition tab, initial water quality of reservoirs. 
2. Alternative Editor - Input Time Series tab, reservoir inflow water quality, 

junction node inflow water quality,  
3. Land Manager Editor - Initial Water Quality of soil water. 
4. Non-Agricultural Land Manager - Initial Water Quality of soil water. 
5. Atmospheric Module Editor - Rainfall Water Quality.  A constant or time series 

can be chosen, if a time series is to be used then it needs to be specified in the 
Alternative Editor on the Input Time Series tab. 

6. Delivery Manager Editor - Management Parameters tab, groundwater quality 
and other supply water quality.  Both of these parameters can be specified as 
either a constant value or a time series, if a time series is to be used then it needs 
to be specified in the Alternative Editor on the Input Time Series tab. 
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Modeling Groundwater in LAWS 
Introduction 
LAWS provides users with two methods to represent groundwater in a model.  The first 
and most straightforward is to simply assign a water table depth to each Land Manager.  
This value is then used in the calculations of water table upflux to determine the effect, if 
any, of the proximity of the water table on soil moisture conditions.  This approach is 
useful when groundwater depth and pumping are not significant concerns for the 
application. A more comprehensive method available to LAWS users is to use discrete 
kernels (aka linear response functions) to represent the dynamic behavior of the 
groundwater system within the study area.  In order to use this approach the LAWS 
user must have a previously built groundwater flow model of the study area using 
the MODFLOW-2005 groundwater modeling code (Harbaugh, 2005) and the SFR1 
streamflow routing package (Prudic, et al., 2004).  This approach also assumes the 
user is a knowledgeable about MODFLOW and is comfortable in determining if and 
where the limiting assumptions inherent in the discrete kernel approach are violated.  
There are many assumptions and restrictions that must be satisfied by the user to properly 
implement this approach; therefore, the user is strongly urged to read the entirety of this 
section on the use of discrete kernels to represent groundwater flow in LAWS. 
 

Discrete Kernel Method 
The theory and application of discrete kernels, also referred to as "Linear Response 
Functions" was developed by several researchers over the past several decades including: 
Maddock (1972), Maddock (1974a), Morel-Seytoux and Daly (1975), and Maddock and 
Lacher (1991).  Some applications of discrete kernels found in the literature include: 
Gupta et al. (1996), Hubbel et al. (1997), Frederick et al. (1998), and Cosgrove and 
Johnson (2005).  A good general description of discrete kernels and associated 
assumptions is provided in Cosgrove and Johnson (2005).  The approach that was 
developed for this work is discussed below. 

Definition and Assumptions 

A discrete kernel is an expression of the expected change in head at a given location due 
to a stress imposed at another location within the groundwater system.  It is a way to 
directly link a localized stress, such as groundwater pumping/recharge or a change in 
stream flow, to each of the modeled cells within its area of influence.  It is a convenient 
and efficient way to predict changes in head without having to explicitly solve 
groundwater flow equations numerically during a LAWS simulation.  A discrete kernel 
may be defined as the ratio of the change in head at a groundwater or stream node 
associated with a particular stress to the stress that caused the change in head or stage.      
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Stress
HeadHead

DK AltOrig −=    

 
where: 
   

DK - Discrete kernel (ft/TAF); 
HeadOrig - Groundwater or stream head without additional stress (ft); 

 HeadAlt - Groundwater or stream head with additional stress (ft); 
 Stress - Volume of water added to groundwater or stream node (TAF). 
 
The intent of the discrete kernel methodology is to translate information contained in a 
groundwater model into a database of coefficients that can be accessed and used by a 
water resources systems model like LAWS to estimate changes in groundwater and 
stream heads given a set of initial conditions and system stresses (i.e. net groundwater 
pumping/recharge, boundary inflows, and changes in stream flow).  Because discrete 
kernels are generated using a calibrated groundwater model, they carry with them all of 
the groundwater system characterization inherent in the groundwater model.  
  
An important assumption associated with the use of discrete kernels is that the equations 
used to calculate groundwater flow and changes in groundwater head are linear.  This 
characteristic has been observed for many confined aquifers. Its validity is important for 
using discrete kernels, which are in effect are constant values used to calculate changes in 
groundwater elevation or river stage per unit of stress.  Where linearity holds it means 
that a single coefficient may be used to characterize the hydraulic head response at a 
given location due to a stress applied at a remote location, where that stress may vary by 
several orders of magnitude throughout the course of a simulation.  This implies, for 
example, that a doubling of a stress will result in a linear doubling the response at another 
location.   
 
Another implication of the linearity assumption is that groundwater and stream responses 
to stresses are reversible.  That is, when a unit of groundwater pumping results in some 
measurable decrease in groundwater head, a similar unit of water that enters the 
groundwater system as recharge will result in a rise in the groundwater level of the same 
magnitude.  
 
The final implication of the linearity assumption is that the property of superposition 
applies.  That is, the hydraulic head change at a given location can be calculated as the 
sum of the responses due to all previous stresses in the groundwater system.  An example 
of this assumption (valid for linear systems) is changes hydraulic head in an observation 
well that is close to a pumping well and a river.  To calculate head changes at the 
observation well, the changes caused by the pumping well and the stream flow changes 
can be added to obtain the net change in head at the observation well.  
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While the assumption of linearity is often reasonable for many groundwater systems, 
there are instances worthy of mention where non-linearities may be introduced.  One 
source of non-linearity is flow in unconfined aquifers. These aquifers are theoretically 
non-linear with respect to head, however, it has been shown that if the change in the 
water table elevation is small in comparison to the saturated thickness of the aquifer, the 
groundwater-stream system behaves in a linear fashion (Maddock, 1974b).   
 
Another potential source of non-linearity is when the water table elevation rises or falls 
below the top or bottom elevations of groundwater model layers.  When water table in a 
MODFLOW cell falls below the top elevation of a layer, MODFLOW switches the node 
from a confined to an unconfined state.  This change results in the use of different storage 
term in the model (ie the storage coefficient in the confined case and specific yield in the 
unconfined case).  These storage terms are often orders of magnitude different and will 
result in very different groundwater responses to system stresses.  Another problem 
occurs when the groundwater elevation falls below the elevation of the bottom of a layer, 
MODFLOW considers such a cell as "dry" and flow is no longer calculated in this cell 
until it meets user defined criteria that allow it to "rewet."  For both cases, it is important 
that the user of the discrete kernel approach in LAWS be aware of these limitations and 
attempt to design a groundwater model that minimizes the likelihood of these events 
occurring.   
 
The interaction between aquifers and streams is also a potential source of non-linearity in 
MODFLOW.  Discrete kernels generated for a connected stream, that is when 
groundwater elevation is greater than the stream bottom elevation, will be different than 
kernels generated while the stream is "disconnected" (ie the reverse condition).  For this 
reason, it is important that the user determine which state is more likely to occur and 
generate discrete kernels accordingly.  It is also incumbent on the user to decide when the 
degree of violation of the linearity assumption makes the application of discrete kernels 
miss leading. 

Artificial Steady State 

It is common within large groundwater systems for changes in hydraulic head to occur 
some time after a stress has been applied, because the responses to a given stress 
generally propagate slowly through the groundwater domain.  Furthermore, once these 
responses have reached their maximum expression, the groundwater system often 
requires a recovery period during which groundwater heads slowly return to their initial 
state (assuming no additional stresses have been applied).  Consequently, stresses may 
influence groundwater heads and stream seepage rates for a significant periods of time 
after a stress has been applied.   
 
However, It is possible to simulate this phenomenon by developing discrete kernels that 
express the magnitude of a response at any future time after an applied stress.  This 
approach is analogous to using a unit hydrograph to describe stream flows for periods 
following a precipitation event.  Implementing the approach requires that the model 
consider time-lagged effects of stresses and reference simulated results from several 
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previous time-steps to determine the current status of groundwater and stream-aquifer 
interactions.  Since stream flows and pumping/recharge rates change continually from 
time-step to time-step, it is imperative that simulated results from previous time-steps be 
properly linked to the appropriate time-lagged effect.  This method creates a large 
computational burden.  Fortunately, there is an alternative approach for implementing 
discrete kernels that requires the groundwater stresses from only one time-step to predict 
changes in groundwater and stream heads through time.  This method uses the concept of 
the "artificial steady state" to define a baseline by which the current stresses can be 
assessed.  The artificial steady state is an assessment of the magnitude of the stresses 
necessary to sustain groundwater and stream heads at their current levels.  (Stated in 
another way, it is the amount of water that needs to be added or removed from a cell in 
order to keep the hydraulic head in the cell constant.)  The difference between the 
simulated stresses and the baseline stresses are the stresses that are applied to calculate 
changes in groundwater and stream heads. 
 
To illustrate the approach, imagine that steady-state groundwater pumping in an aquifer 
with an initially flat groundwater surface results in the drawdown pattern shown in Figure 
5.  In this hypothetical example, we assume for simplicity that the system is initially in 
equilibrium, that the simulated pumping rate is 1000 cfs per time-step, that the areal 
recharge rate is 0 cfs, and that the discrete kernel for a change in groundwater head due to 
net pumping/recharge is 0.0063 ft/cfs.  When pumping begins in the first month of the 
simulation the baseline stress is 0 cfs, because the system is initially at equilibrium.  
Drawdown for the first month is then calculated by multiplying the discrete kernel times 
the full 1000 cfs pumping stress.  This stress results in a drawdown of 6.3 ft (i.e. 0.0063 
ft/cfs * {1000 cfs – 0 cfs}).   

   
 

FIGURE 5 - TYPICAL DRAWDOWN UNDER STEADY STATE GROUNDWATER PUMPING 

At the beginning of a second time-step the system is no longer in equilibrium, so we must 
calculate an artificial steady state condition for maintaining groundwater head at 6.3 ft 
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below the initial elevation.  This amount of pumping turns out to be of 630 cfs.  Now, to 
calculate the change in groundwater head for the second time-step, we multiply the 
difference between the 1000 cfs steady pumping rate and the 630 cfs baseline stress times 
the discrete kernel.  This results in an additional drawdown of 2.33 ft (i.e. 0.0063 ft/cfs * 
{1000 cfs – 630 cfs}) which brings the groundwater head down to 8.63 ft (i.e. 6.3 ft + 
2.33 ft) below the initial elevation.  Notice that the hydraulic effect of the dynamically 
expanding cone of depression has been captured even though we’re are using a single 
constant discrete kernel. 
 
To continue the example, at the beginning of the third time-step, we calculate a baseline 
stress for maintaining the groundwater head at 8.63 ft below the initial elevation.  This 
turns out to be 863 cfs.  So, to calculate the change in groundwater head for the third 
time-step, we multiply the difference between the 1000 cfs steady pumping rate and the 
863 cfs baseline stress times the discrete kernel.  This results in an additional drawdown 
of 0.86 ft (i.e. 0.0063 ft/cfs * {1000 cfs – 863 cfs}) and brings the groundwater head 
down to 9.49 ft (i.e. 8.63 ft + 0.86 ft) below the initial elevation. 
 
This procedure can be repeated until the groundwater head approaches 10 ft below the 
initial elevation.  At that point, the baseline stress for maintaining the groundwater head 
at that level approaches 1000 cfs.  This results in little further drawdown, because the 
baseline stress is almost equal to the steady pumping rate.  When the pumping stress is 
shut off, the change in head will be described as 0.0063 ft/cfs*(0 cfs – 10000 cfs) or -6.3 
feet (negative is a water table recovery) and the system will begin to respond back 
towards its initial equilibrium flat aquifer condition. 
 
The example above illustrates how the concept of the artificial steady state can be used to 
propagate groundwater responses to stresses through time.  This routine is very important 
in the context of this current work, because it significantly reduces the computational 
requirements for calculating groundwater and stream-aquifer responses using discrete 
kernels, because the time lag effects of a particular stress do not need to be stored in a 
database and managed during a simulation. 
 

Discrete Kernel Implementation in LAWS 
To develop a LAWS model that employs the discrete kernel methodology the user must 
perform the following series of steps to prepare the necessary input files that LAWS 
needs. 
 

MODFLOW Model Requirements 
The user is required to have functioning MODFLOW model of the study area.  The the 
LAWS model supports the following MODFLOW packages: 
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1. BCF6 - block centered flow 
2. BAS6 - basic  
3. DIS - discretization 
4. SFR - streamflow-routing 1 (SFR1) 
5. GHB - general head boundary 
6. DRN - drain boundary 
7. WEL - well boundary  

 
The following are the requirements that must be met in order to have the model run 
correctly: 
 

1. The user must use the BCF6 package and not the LPF package. 
2. The MODFLOW model must only have contiguous layers – no confining beds. 
3. The user must specify conductivity, not transmissivity in the BCF6 input file. 
4. The conductivity is isotropic. 
5. The user must specify leakance (VCONT). 
6. LAYCON (right digit of Ltype) will equal 1 or 3 (variable transmissivity, head 

dependent). 
7. The left digit of Ltype will be equal to 0 which specifies the use of the harmonic 

mean in calculating interblock transmissivity. 
8. The stream network cannot have a single stream splitting into two tributaries.  For 

instance, there cannot be an explicitly modeled canal diverting water from a 
stream.  Diversions must only occur through linkages to delivery managers. 

 
Specification of input for the streamflow-routing package also has some important 
requirements: 

 
9. Each stream segment can have only one reach. 
10. The user must specify the stream head v. flow v. width relationship using the 

rating table, ICALC = 4. 
11. The stream(s) must interact with the aquifer only through layer 1. 

 
 
In constructing the MODFLOW model the user should create a Name file (*.nam) that 
lists all the package input files and all input files referenced in the package input files as 
DATA files.  The files listed in the name file should be referenced only by their name 
with no path.  The OPEN/CLOSE command can not be used in the input files, only the 
EXTERNAL command can be used to reference other data files. The reason for this is 
that LAWS will read the name file and copy all listed files into the LAWS directory.  If 
any necessary files are not listed in the name file the model will not run correctly.  In the 
Name file all unit numbers should be less than 999.  When the MODFLOW files are 
copied they will be placed in subdirectory "/modflow/FlowNet" under the project 
directory where FlowNet is the name of the flow network that the MODFLOW model is 
associated with. 
 



Technical Reference 

162 

Stream Network Consistency 
The stream networks defined in the MODFLOW and LAWS models must be completely 
consistent.  It was assumed that users have a GIS file containing the stream network used 
in the MODFLOW model and that this file would be used as the basis for the 
construction of the stream network in LAWS.  This could be most easily be done using 
the Stream Network Import functionality provided in LAWS.  The stream networks must 
be consistent because LAWS will read the MODFLOW files and compare them to the 
LAWS stream network and construct a lookup table that relates LAWS junction nodes to 
MODFLOW stream nodes.  LAWS will place this file (NodeMap.txt) in the "modflow" 
directory  
 

Pumping Fraction File 
The LAWS user is required to provide a pumping fraction file.  The purpose of this file is 
to provide the vertical pumping distribution for each row and column location in the 
MODFLOW model.  As such, this file should contain a series of NLAY arrays (NCOL x 
NROW) that contain the proportion of the pumping that will occur in each layer at each 
column, row location.  Ideally, these proportions will sum to 1.0 for each column, row 
location, however, LAWS will normalize them if necessary. If all values for a given 
column, row location in the file are zero it is assumed that pumping occurs in the top 
layer. 
  

Discrete Kernel File 
The generation of discrete kernels is done using a modified version of MODFLOW-2005.  
The executable is included in the LAWS installation directory and is called 
DK_Code.exe.  In order to properly run this code, a MODFLOW model is needed.  For 
the model to be used to generate discrete kernels, the following requirements must be 
met:  
 

1. The model must use a time unit of days.  The length units, either feet or meters, 
must match the units used in LAWS. 

2. The model is setup to run for one stress period only.  The stress period length 
must be one day. 

3. The initial heads are set in such a manner that the discrete kernels generated are 
what the user needs.  For instance, aquifer heads in cells containing stream nodes 
are set so that the stream is disconnected or connected depending on the 
requirements of the user. 

4. The model must be setup so that there is stream flow in every stream segment 
during the stress period.  The reason for this is that the discrete kernels are 
calculated by adding additional flow to each segment.  
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5. It is assumed that the MODFLOW model could have any combination of the 
following boundary conditions: 

a. Streams – using the SFR1 package. 
b. General head boundaries – using the GHB package. 
c. Well boundaries – using the WEL package. 
d. Drain boundaries - using the DRN package. 
e. Constant head boundaries can be represented using the initial head and the 

IBOUND < 0. 
6. Discrete kernels will be generated using the WEL and SFR1 packages.  The 

program does not currently support the RIV package or any reservoir or lake 
packages. 

7. The name file must have an SFR1 and WEL packages listed.  It is assumed that 
the model of interest will have streams in it and therefore it is a requirement that 
the SFR1 package is listed in the name file.  It is not required that wells be in the 
model, however, it is required that the WEL package be listed in the name file and 
that if no wells are in the model that information similar to the following be 
entered into the WEL package input file: 

 
# Well file 

         1         0 
         0         0 

           
 

8. The code creates stream stresses by adding water to each stream segment through 
the FLOW variable.  It is assumed that each segment has only one reach.  

 
To create the discrete kernel file, run the utility DK_Code.exe.  This utility should be 
copied into the directory that contains the MODFLOW input files since it expects all 
files to be located in the same directory as it is located.  The utility generates discrete 
kernels by first running the model with only the stresses that are specified in the input 
files provided by the user.  Second, it runs the model with one additional stress 
(pumping or increased streamflow) and compares the resulting heads with those from 
the first run.  The discrete kernels are calculated as the ratio of the change in head 
over the magnitude of the stress.  
 
The utility requires the presence of an input file called "DKGen_Input.txt".  This file 
uses a free format read and contains: 
 
NameFileName - the name of the MODFLOW model's name file. 
 
Min_DK - this value determines how many of the calculated discrete kernels to keep 
in the output file.  All discrete kernels less than Min_DK are discarded and not 
written to the output file.  There is a tradeoff associated with the magnitude of this 
value.  If a small value is used for Min_DK then more discrete kernels will be written 
to the output file.  This will result in a more accurate simulation of the groundwater 
system.  However, if more discrete kernels are saved then the groundwater simulation 
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will take longer to execute.  Experience has shown that a value around 1e-6 will yield 
an accurate simulation in most cases.  Users are urged to experiment with smaller or 
larger values to see if potential gains in simulation run time or model accuracy can be 
made. 
 
PumpDepth -  this value determines the magnitude of the pumping stress that is 
applied to the groundwater system within each cell. A value of 0.25 ft, 0.075 m, or 
7.5 cm, depending on MODFLOW length units, yields acceptable discrete kernels. 
 
StrmStressFrac - this value is used to calculate the magnitude of the stream flow 
stress using the following: 
 
Stress = StreamFlow (StrmStressFrac - 1) 
 
A value of 1.1 often yields acceptable results. 
 
The MODFLOW 2005 code was modified by creating a program named “DK_Code” 
which calls MODFLOW 2005 as a subroutine.  The gwf2bas7.f, gwf2gag7.f, 
gwf2sfr7, gwf2wel7.f, mf2005.f, and utl7.f files were altered in order to have 
MODFLOW 2005 interact correctly with the code presented in DK_Code.f90.  At 
every location that an alteration was made to the original code, 2 comment lines were 
added (one before and one after the alteration) that contains the string “CYoung”.  
This was done so that users can quickly locate all changes to the original MODFLOW 
2005 code. 

Initial Conditions 

An initial conditions file must be provided that specifies the initial stream water surface 
elevations.  The file must contain one comment line and then an entry for each stream 
node in the MODFLOW model: 
 
"Initial Stream Heads" 
InitialStreamhead(segment 1) 
InitialStreamhead(segment 2) 
InitialStreamhead(segment 3) 
. 
. 
. 
InitialStreamhead(segment NSS) 
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Running the Groundwater Model 
Once the appropriate input files have been created (as described above), a discrete kernel 
representation of the MODLFOW model can be joined to an existing LAWS model.  This 
is done by associating the set of MODFLOW input files with a particular flow network 
module.  Groundwater models are associated with Flow Network Modules because the 
groundwater model must have the same streams as defined in the flow network.   
 
To initialize a discrete kernel model, right click on the flow network's name in the project 
tree and select "Edit."  Next, select "Groundwater."  The following dialog will appear: 
 

 
 
To activate the discrete kernel groundwater model place a "check" in the "Use 
Groundwater Model" box.  The following inputs are required: 
 
MODFLOW Name File - Enter the path and name of the MODFLOW name file.  
LAWS will read this file to determine which files need to be copied from the 
MODFLOW model directory into the LAWS project directory.  The files will be placed 
in /Project Directory Name/modflow/Flow Network Name/. 
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Discrete Kernel File - Enter the path and name of the file containing the discrete kernels.  
This file should have been generated by DK_Code.exe utility that resides in the LAWS 
installation directory.  LAWS will copy this into /Project Directory Name/modflow/Flow 
Network Name/. 
 
Vertical Pumping Dist. File - iEnter the path and name of the file containing the vertical 
pumping distribution.  LAWS will copy this into /Project Directory Name/modflow/Flow 
Network Name/. 
 
Initial Stream Head File - Enter the path and name of the file that contains the initial 
stream head values (in elevation, not depth).  LAWS will copy this into /Project 
Directory Name/modflow/Flow Network Name/. 
 
NW X-Coordinate - Enter the x-coordinate of the northwest corner of the model domain.  
This value needs to be in the same coordinate system as the LAWS model and the 
MODFLOW model.  This value will be used by LAWS to determine where to start 
drawing the model grid on the LAWS schematic. 
 
NW Y-Coordinate - Enter the y-coordinate of the northwest corner of the model domain.  
This value needs to be in the same coordinate system as the LAWS model and the 
MODFLOW model.  This value will be used by LAWS to determine where to start 
drawing the MODFLOW model grid on the LAWS schematic. 
 
Angel of Rotation - Enter the angle of rotation that will be used in draw the MODFLOW 
model grid on the LAWS schematic.  If the grid has not been rotated (cell boundaries run 
east-west and north-south) then enter a value of 0.0.  
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